SAP BusinessObjects Analysis, edition for OLAP Administrator Guide
# Content

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  Document History.</td>
<td>6</td>
</tr>
<tr>
<td>2  Introduction to SAP BusinessObjects Analysis, edition for OLAP.</td>
<td>9</td>
</tr>
<tr>
<td>2.1 Components of Analysis, edition for OLAP.</td>
<td>9</td>
</tr>
<tr>
<td>Analysis client.</td>
<td>9</td>
</tr>
<tr>
<td>Analysis Multi-Dimensional Analysis Service.</td>
<td>9</td>
</tr>
<tr>
<td>2.2 About this guide.</td>
<td>10</td>
</tr>
<tr>
<td>The documentation set.</td>
<td>10</td>
</tr>
<tr>
<td>Who should read this guide.</td>
<td>11</td>
</tr>
<tr>
<td>3  Architecture.</td>
<td>12</td>
</tr>
<tr>
<td>3.1 Analysis architecture diagram.</td>
<td>12</td>
</tr>
<tr>
<td>3.2 SAP BusinessObjects Business Intelligence platform deployment model.</td>
<td>14</td>
</tr>
<tr>
<td>3.3 Multi-Dimensional Analysis Service.</td>
<td>15</td>
</tr>
<tr>
<td>Server failover.</td>
<td>15</td>
</tr>
<tr>
<td>4  Installation and Configuration.</td>
<td>16</td>
</tr>
<tr>
<td>4.1 Administrative tools.</td>
<td>16</td>
</tr>
<tr>
<td>Central Management Console (CMC).</td>
<td>16</td>
</tr>
<tr>
<td>Central Configuration Manager (CCM).</td>
<td>16</td>
</tr>
<tr>
<td>4.2 Installation notes.</td>
<td>16</td>
</tr>
<tr>
<td>4.3 Data sources.</td>
<td>16</td>
</tr>
<tr>
<td>4.4 Web application server configuration.</td>
<td>17</td>
</tr>
<tr>
<td>4.5 Post-installation configuration of fonts.</td>
<td>18</td>
</tr>
<tr>
<td>4.6 To configure the BI platform for Essbase OLAP connections.</td>
<td>20</td>
</tr>
<tr>
<td>4.7 Firewall port usage.</td>
<td>21</td>
</tr>
<tr>
<td>4.8 Cloning Analysis server deployments.</td>
<td>21</td>
</tr>
<tr>
<td>4.9 Settings for preloading hierarchy metadata.</td>
<td>21</td>
</tr>
<tr>
<td>4.10 Prompt validation.</td>
<td>22</td>
</tr>
<tr>
<td>4.11 Displaying workspaces in quirks mode.</td>
<td>22</td>
</tr>
<tr>
<td>To set all workspaces to run in quirks mode.</td>
<td>23</td>
</tr>
<tr>
<td>To set individual workspaces to run in quirks mode.</td>
<td>23</td>
</tr>
<tr>
<td>4.12 Export limit.</td>
<td>24</td>
</tr>
<tr>
<td>4.13 Member selector cache limit.</td>
<td>24</td>
</tr>
<tr>
<td>4.14 Session timeout settings.</td>
<td>25</td>
</tr>
<tr>
<td>4.15 Accessibility.</td>
<td>26</td>
</tr>
<tr>
<td>4.16 SAP Notes required.</td>
<td>26</td>
</tr>
<tr>
<td>4.17 Oracle OLAP Data Provider for SAP BusinessObjects Business Intelligence.</td>
<td>26</td>
</tr>
</tbody>
</table>
Software requirements for the Oracle OLAP Data Provider. ............................................. 27
Oracle OLAP Data Provider installation package. ................................................................. 28
Configuring the Oracle OLAP Data Provider. ................................................................... 30
Configuring JVM memory usage. ....................................................................................... 35
Running the web server and XMLA service. ................................................................. 35
Testing your installation. ................................................................................................. 38
Using JConsole to monitor the Oracle OLAP Data Provider. ........................................ 39
To enable the Oracle OLAP Data Provider for Analysis. .............................................. 42
Uninstalling the Oracle OLAP Data Provider. ............................................................... 42
Using logging to troubleshoot MDX and SQL issues. .................................................... 43

5 Security .......................................................................................................................... 46
5.1 Configuring the MDAS for Secure Sockets Layer (SSL). ........................................... 46

6 Rights Management ....................................................................................................... 47
6.1 Overview of rights and access levels. ....................................................................... 47
6.2 Create Analysis Workspace right. .............................................................................. 47
6.3 Rights for Analysis objects. ....................................................................................... 48
6.4 Access levels for Analysis objects. .............................................................................. 50
6.5 Data access. ................................................................................................................. 51
6.6 Changing access to Analysis workspaces. ................................................................. 53
6.7 Setting rights for custom groups. ............................................................................... 53

To set rights for editing or deleting custom groups. ......................................................... 53
To set rights for sharing custom groups. ............................................................................ 54

6.8 Export to Analysis Application right. ........................................................................ 55

To grant the right to export a workspace as an analysis application. ................................ 55

7 MDAS Maintenance ....................................................................................................... 56
7.1 Starting and stopping the Server Intelligence Agent. .................................................. 56
7.2 Starting and stopping the Multi-Dimensional Analysis Service. ................................ 56
7.3 Restarting the Multi-Dimensional Analysis Service. .................................................. 56
7.4 Enabling and disabling an MDAS instance. ............................................................... 57
7.5 Adding and removing MDAS instances. ................................................................... 57
7.6 Configuration files for the MDAS Server. ................................................................. 57

MDAS configuration file—mdas.properties. ................................................................... 58
MDAS client configuration file—mdaclient.properties. ................................................... 59

7.7 MDAS properties and metrics. .................................................................................. 61

Properties page. ............................................................................................................... 61
Metrics page. ..................................................................................................................... 62

8 Data Source Connections .............................................................................................. 63
8.1 Creating OLAP data source connections. ................................................................. 63

Finding a cube or query. .................................................................................................. 65
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication</td>
<td>67</td>
</tr>
<tr>
<td>To change connection settings</td>
<td>69</td>
</tr>
<tr>
<td>Deleting a connection</td>
<td>70</td>
</tr>
<tr>
<td>Moving a connection to another folder</td>
<td>71</td>
</tr>
<tr>
<td>Data source connection settings</td>
<td>71</td>
</tr>
<tr>
<td>Connection settings for SAP Business Warehouse data sources</td>
<td>72</td>
</tr>
<tr>
<td>Connection settings for Microsoft Analysis Services data sources</td>
<td>73</td>
</tr>
<tr>
<td>Connection settings for SAP BusinessObjects Profitability and Cost Management data sources</td>
<td>74</td>
</tr>
<tr>
<td>Connection settings for SAP BusinessObjects Extended Analytics data sources</td>
<td>74</td>
</tr>
<tr>
<td>Connection settings for SAP BusinessObjects Planning and Consolidation data sources</td>
<td>75</td>
</tr>
<tr>
<td>Connection settings for SAP HANA data sources</td>
<td>76</td>
</tr>
<tr>
<td>Connection settings for SAP HANA HTTP</td>
<td>76</td>
</tr>
<tr>
<td>Connection settings for Teradata data sources</td>
<td>79</td>
</tr>
<tr>
<td>Connection settings for Oracle Essbase data sources</td>
<td>79</td>
</tr>
<tr>
<td>Connection settings for Oracle OLAP data sources</td>
<td>80</td>
</tr>
<tr>
<td>Managing Analysis data source connections</td>
<td>81</td>
</tr>
<tr>
<td>Editing the title and description of an Analysis data source connection</td>
<td>81</td>
</tr>
<tr>
<td>Displaying a list of workspaces that use a data source connection</td>
<td>82</td>
</tr>
<tr>
<td>Changing access to Analysis data source connections</td>
<td>82</td>
</tr>
<tr>
<td>Replacing an Analysis data source connection</td>
<td>83</td>
</tr>
<tr>
<td>Configuring connections for Report-Report Interface</td>
<td>84</td>
</tr>
<tr>
<td>Enabling SAP BW query targets for the Report-Report Interface</td>
<td>84</td>
</tr>
<tr>
<td>Enabling single sign-on for RRI</td>
<td>84</td>
</tr>
<tr>
<td>Managing Workspaces</td>
<td>86</td>
</tr>
<tr>
<td>Overview</td>
<td>86</td>
</tr>
<tr>
<td>Editing the title, description, and keywords of an Analysis workspace</td>
<td>86</td>
</tr>
<tr>
<td>Displaying a list of connections linked to the workspace</td>
<td>87</td>
</tr>
<tr>
<td>Sharing Workspaces</td>
<td>88</td>
</tr>
<tr>
<td>Sharing workspaces using OpenDocument URLs</td>
<td>88</td>
</tr>
<tr>
<td>Setting prompt values using parameterized OpenDocument URLs</td>
<td>88</td>
</tr>
<tr>
<td>Creating parameterized OpenDocument URLs</td>
<td>88</td>
</tr>
<tr>
<td>Scaling and Performance</td>
<td>90</td>
</tr>
<tr>
<td>Clustering MDAS instances</td>
<td>90</td>
</tr>
<tr>
<td>Load balancing</td>
<td>90</td>
</tr>
<tr>
<td>Optimizing performance</td>
<td>90</td>
</tr>
<tr>
<td>Configuring Analysis for scalability against Essbase 11 data sources</td>
<td>91</td>
</tr>
<tr>
<td>Increasing available ephemeral ports</td>
<td>91</td>
</tr>
<tr>
<td>Reducing the TIME_WAIT state</td>
<td>92</td>
</tr>
<tr>
<td>Increasing the connection retry count</td>
<td>92</td>
</tr>
</tbody>
</table>
12 Monitoring and Logging. ................................................................. 93
12.1 Auditing. .............................................................................. 93
12.2 Trace logging. ..................................................................... 93
12.3 To enable statistics for Analysis on an SAP BW server. ......... 93

13 Microsoft Analysis Services Considerations. .............................. 95
13.1 IIS configuration for MSAS connectivity. ................................. 95
   Copy required files. ............................................................... 95
   Create an Application Pool. .................................................. 96
   Create a Virtual Directory. ...................................................... 96
   Configure Security. .............................................................. 96
   Set up a Web Service Extension. ............................................ 97
13.2 Analysis, edition for OLAP and Analysis Services security. ......... 97
   Analysis Services role security. ............................................. 97
   Finding more information. .................................................... 98

14 Converting Workspaces to Analysis. ............................................ 99
14.1 Converting workspaces from Voyager to Analysis, edition for OLAP. .... 99

15 Translating workspaces. ........................................................... 100
15.1 Preparing Analysis workspaces for translation. ......................... 100
1  Document History

The following table provides an overview of the most important document changes.

<p>| Version                                                        | Date       | Description                                                                 |
|                                                               |            |                                                                            |
| SAP BusinessObjects Analysis, edition for OLAP 4.1 Support Package 1 | August 2013 | Added support for Oracle OLAP Data Provider for SAP Business Intelligence.  |
|                                                               |            | Oracle OLAP Data Provider for SAP BusinessObjects Business Intelligence [page 26] |
|                                                               |            | Connection settings for Oracle OLAP data sources [page 80]                 |
|                                                               |            | Added information about configuring Analysis for scalability when connecting to Oracle Essbase data sources. |
|                                                               |            | Configuring Analysis for scalability against Essbase 11 data sources [page 91] |
| SAP BusinessObjects Analysis, edition for OLAP 4.1 Support Package 2 | November 2013 | Updated information about rights for creating workspaces:                   |
|                                                               |            | Create Analysis Workspace right [page 47]                                  |
|                                                               |            | Updated the mdas.properties file listing:                                  |
|                                                               |            | mdas.properties file listing [page 58]                                     |
| SAP BusinessObjects Analysis, edition for OLAP 4.1 Support Package 3 | March 2014  | Added information about preloading hierarchy metadata:                      |
|                                                               |            | Settings for preloading hierarchy metadata [page 21]                       |
|                                                               |            | Added information about configuring prompt validation:                     |
|                                                               |            | Prompt validation [page 22]                                                |</p>
<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP BusinessObjects Analysis, edition</td>
<td>June 2014</td>
<td>Added information on running Analysis in quirks mode:</td>
</tr>
<tr>
<td>for OLAP 4.1 Support Package 4</td>
<td></td>
<td>Displaying workspaces in quirks mode [page 22]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added information about configuring the cache limit for the Member Selector dialog box:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Member selector cache limit [page 24]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Updated the mdas.properties file listing:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>mdas.properties file listing [page 58]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Updated the mdaclient.properties file listing:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>mdaclient.properties parameters [page 60]</td>
</tr>
<tr>
<td>SAP BusinessObjects Analysis, edition</td>
<td>November 2015</td>
<td>Added a reference to the Simba XMLA for Oracle OLAP: Administrator Guide:</td>
</tr>
<tr>
<td>for OLAP 4.2</td>
<td></td>
<td>Oracle OLAP Data Provider for SAP BusinessObjects Business Intelligence [page 26]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added information on preparing workspaces for translation:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Preparing Analysis workspaces for translation [page 100]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added Connection settings for SAP HANA HTTP Connection settings for SAP HANA HTTP [page 76]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added Configuration settings for SAP HANA HTTP Configuration for SAP HANA HTTP [page 77]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added Creating an SAP HANA HTTP connection on BI platform Creating an SAP HANA HTTP connection on the BI platform [page 77]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added Troubleshooting for SAP HANA HTTP connections Troubleshooting for SAP HANA HTTP connections [page 78]</td>
</tr>
<tr>
<td>Version</td>
<td>Date</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>SAP BusinessObjects Analysis, edition for OLAP 4.2 Support Package 01</td>
<td>December 2015</td>
<td>Updated with only branding changes</td>
</tr>
<tr>
<td>SAP BusinessObjects Analysis, edition for OLAP 4.2 Support Package 02</td>
<td>March 2016</td>
<td>Updated with only branding changes</td>
</tr>
</tbody>
</table>
2 Introduction to SAP BusinessObjects Analysis, edition for OLAP

2.1 Components of Analysis, edition for OLAP

SAP BusinessObjects Analysis, edition for OLAP is a query and analysis tool that business analysts in your organization can use to analyze your organization’s multidimensional data. Users access Analysis from within the BI launch pad in SAP BusinessObjects Business Intelligence platform (the “BI platform”), and then create, save, and share their analysis workspaces in the BI platform repository. Once the workspaces are saved to the repository, other analysts or business users can work with those analyses over any web connection.

Analysis administrators configure and maintain the Multi-Dimensional Analysis Service (MDAS), manage access rights, set up connections to OLAP data sources, manage workspace and data source objects in the BI platform repository, and perform many other administrative tasks.

SAP BusinessObjects Analysis, edition for OLAP comprises these components:

- Components of Analysis, edition for OLAP [page 9]
- Analysis Multi-Dimensional Analysis Service [page 9]

Note

SAP BusinessObjects Analysis, edition for Microsoft Office, although related very closely to SAP BusinessObjects Analysis, edition for OLAP, has its own documentation set, including its own administrator guide.

2.1.1 Analysis client

The Analysis client application is the end-user component of SAP BusinessObjects Analysis, edition for OLAP. It is installed with SAP BusinessObjects Business Intelligence platform, and is accessed from within the BI launch pad.

Data analysts use the Analysis client application to perform their data-analysis work and save their analyses to the BI platform.

Users need only an internet connection, web browser software, and sufficient rights, to access the BI platform system and create or view Analysis workspaces.

2.1.2 Analysis Multi-Dimensional Analysis Service

Analysis includes a Java BI platform service called the Multi-Dimensional Analysis Service (MDAS). The MDAS is installed with SAP BusinessObjects Business Intelligence platform, and is administered from within the BI platform’s Central Management Console (CMC).
The MDAS processes analysis requests from the Analysis client, retrieves OLAP data from the OLAP server, adds formatting, filtering, and highlighting information to the data, and sends the processed data back to the client application for display.

The MDAS is a service within an Adaptive Processing Server (APS). The APS can be configured and managed in the Central Management Console (CMC). For more information about the APS and CMC, see the *SAP BusinessObjects Business Intelligence Platform Administrator Guide*.

### 2.2 About this guide

#### 2.2.1 The documentation set

The documentation set comprises these guides and online help information:

**SAP BusinessObjects Analysis, edition for OLAP User Guide**

This guide contains the conceptual information, procedures, and reference material required to use Analysis.

**SAP BusinessObjects Analysis, edition for OLAP Online Help**

The online help is optimized to provide quick answers for everyday tasks in Analysis.

**SAP BusinessObjects Analysis, edition for OLAP Administrator Guide**

This guide contains detailed information that is useful to a system administrator when installing, configuring, and administering Analysis.

This Administrator Guide is a supplement to the *SAP BusinessObjects Business Intelligence Platform Administrator Guide* and *SAP BusinessObjects Business Intelligence Platform Installation Guide*, and provides information to help you administer an Analysis installation. The information in the BI platform guides applies to all SAP BusinessObjects servers and services, including the Multi-Dimensional Analysis Service. Consult the BI platform guides if you cannot find the information you seek in this guide.

For a description of the BI platform components and installation instructions, and for installation instructions for Analysis, see the *SAP BusinessObjects Business Intelligence Platform Installation Guide* and *SAP BusinessObjects Business Intelligence Platform Administrator Guide*.

For information on performance optimization see the *SAP BusinessObjects BI Sizing Companion Guide*. 

© 2016 SAP SE or an SAP affiliate company. All rights reserved.
Note
Throughout this guide, the term "UNIX" is used to refer to all UNIX-related platforms collectively.

Note
SAP BusinessObjects Analysis, edition for Microsoft Office, although related very closely to SAP BusinessObjects Analysis, edition for OLAP, has its own documentation set, including its own administrator guide.

2.2.2 Who should read this guide

This guide is intended for system administrators. You need administrator rights to administer SAP BusinessObjects Analysis, edition for OLAP and SAP BusinessObjects Business Intelligence platform.
3 Architecture

3.1 Analysis architecture diagram
3.2 SAP BusinessObjects Business Intelligence platform deployment model

SAP BusinessObjects Analysis, edition for OLAP fits into the broader BI platform architecture as a client-server setup with connections at the server and database levels to other BI platform servers.
3.3 Multi-Dimensional Analysis Service

The Multi-Dimensional Analysis Service is fully integrated with the BI platform. Like the other BI platform servers and services, it registers itself with the Central Management Server (CMS). Once registered, it is available for consumption by the Analysis web client.

The MDAS provides BI platform client applications such as Analysis, edition for OLAP with an extensible and efficient framework for accessing multi-dimensional (OLAP) data. It not only provides access to multi-dimensional data but also converts the raw data into various XML packages, which the requesting client application then renders into a specific presentation format: Excel spreadsheet, PDF, or Analysis crosstabs and charts.

3.3.1 Server failover

You may run multiple MDAS instances to accommodate a large number of users, or to provide redundancy if an MDAS should fail for any reason. If an MDAS fails, users on the failed MDAS are automatically moved to another available MDAS. Where possible, the failed user sessions are recovered and restored on the other MDAS. If the server fails before an action is completed, users may need to redo their last actions when their sessions are moved to a new MDAS.

If an MDAS fails, and if other MDAS services do not have sufficient remaining capacity to accommodate the user sessions from the failed MDAS, the failed workspaces are autosaved to the Inbox folder in the BI platform, and those users are sent a notification. The users can later reload their workspaces and continue with their analyses.
4 Installation and Configuration

4.1 Administrative tools

4.1.1 Central Management Console (CMC)

The Central Management Console (CMC) is a web-based administration tool for managing Analysis data sources and workspaces, user accounts, rights, folders, and server settings. You also use the CMC to perform all MDAS administrative tasks. You must be a BI platform administrator to access the CMC.

4.1.2 Central Configuration Manager (CCM)

The Central Configuration Manager (CCM) is a server-management tool that allows you to configure servers for your SAP BusinessObjects products on Windows. For Analysis, use the CCM to start and stop the Server Intelligence Agent (SIA). For all other administrative tasks, use the Central Management Console.

Related Information

- Starting and stopping the Server Intelligence Agent [page 56]
- Central Management Console (CMC) [page 16]

4.2 Installation notes

Analysis, edition for OLAP is installed as part of the SAP BusinessObjects Business Intelligence platform suite of products. For more information about installing products in that suite, including Analysis, edition for OLAP, see the SAP BusinessObjects Business Intelligence Platform Installation Guide.

For information about platforms supported by Analysis, refer to the Product Availability Matrix. A link to this document is available on the SAP Help Portal page for Analysis at http://help.sap.com/boaolap41, in the Additional Information section.

An Adaptive Processing Server instance is created automatically during installation. When deploying to production, the recommended deployment method is to create another Adaptive Processing Server instance that contains only the MDAS, auditing, and monitoring services. For more information, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.
The SAP HANA client is automatically installed when you install the BI platform, allowing you to create connections to SAP HANA data sources.

For information about configuring IIS for connecting to Microsoft Analysis Services data sources, see IIS configuration for MSAS connectivity [page 95].

For information about configuring the BI platform to connect to Essbase data sources, see To configure the BI platform for Essbase OLAP connections [page 20].

**Note**

Before users can begin working with Analysis, you must create at least one data source object. For information about creating Analysis data source objects, see Creating OLAP data source connections [page 63].

**Note**

After installing Analysis, you may have to configure the fonts.xml file to have properly-rendered charts. For details on how to do this, see Post-installation configuration of fonts [page 18].

**Note**

You may also have to configure your web application server. For more information, see Web application server configuration [page 17].

### 4.3 Data sources

Analysis requires a connection to a supported OLAP data source, such as SAP BW, or Microsoft Analysis Services. Therefore, you must create at least one data source object before analysts can begin using Analysis to analyze data.

### 4.4 Web application server configuration

The supported web application servers do not require any special configuration to work properly with Analysis, with these exceptions:

- **Sun Java System Application Server 9.1**
  
  Add `-Xmx1024m -XX:MaxPermSize=256m` as additional options to the JVM.

- **JBoss Application Server 4.2.3 & 5.0 GA**
  
  In the run.conf file, add this line:
  
  ```
  JAVA_OPTS="-server -Xmx1024m -XX:MaxPermSize=512m -Dsun.rmi.dgc.client.gcInterval=3600000 -Dsun.rmi.dgc.server.gcInterval=3600000"
  ```
4.5 Post-installation configuration of fonts

If you need to use a Unicode font such as Japanese, or if you are running a UNIX platform, you must make a manual change to view charts and exported PDF files correctly. The font being used can be changed by editing `fonts.xml`.

On Windows, the `fonts.xml` file is located in this folder: `C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\java\pjs\services\MDAS\resources\com\businessobjects\multidimensional\services`

On UNIX, the `fonts.xml` file is located in this directory: `<SAP BusinessObjects Business Intelligence platform installation directory>/sap_bobj/enterprise_xi40/java/pjs/services/MDAS/resources/com/businessobjects/multidimensional/services`

Add the new font definition to `fonts.xml`. In the font definition, specify the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>The name of the font. This name must match the name of a font available on the font path of the operating system that the MDAS is running on.</td>
</tr>
<tr>
<td>caption</td>
<td>The caption of the font. Type the name that you want to display in the Font list on the chart Properties panel.</td>
</tr>
<tr>
<td>resourceURL</td>
<td>The URL of the font. For non-TrueType Collection fonts, the URL follows this format: <code>file:///&lt;pathname of the font on the file system&gt;</code></td>
</tr>
<tr>
<td></td>
<td>TrueType Collection font files contain multiple fonts, each identified by a zero-based index number. For TrueType Collection fonts, you must add the appropriate index number to the <code>resourceURL</code>. The URL follows this format: <code>file:///&lt;pathname of the font on the file system&gt;,&lt;index number&gt;</code></td>
</tr>
<tr>
<td></td>
<td>The following are examples of the <code>resourceURL</code> for TrueType Collection fonts:</td>
</tr>
<tr>
<td></td>
<td>- MingLiU on Windows: <code>WINDOWS/Fonts/mingliu.ttc,0</code></td>
</tr>
<tr>
<td></td>
<td>- PMingLiU on Windows: <code>WINDOWS/Fonts/mingliu.ttc,1</code></td>
</tr>
<tr>
<td>type</td>
<td>The type of the font. For example, TrueType or TrueTypeCollection.</td>
</tr>
<tr>
<td>locale</td>
<td>The locale that this font is assigned to.</td>
</tr>
</tbody>
</table>
To set the new font as the default for all locales that do not have a font specified in the `fonts.xml` file, set the `universalFontName` attribute to the name of the font.

Here is a sample Windows file listing:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<!--
MDAS Font Configuration
Replace paths to font with the correct path for the installed system
example of some locale mapping
==============================
English  - "en"
French      - "fr"
German      - "de"
Italian  - "it"
Japanese - "ja"
Korean      - "ko"
Chinese  - "zh"
-->
<fon:ServerFonts
universalFontName="Arial"
xmlns:fon="http://www.businessobjects.com/xml/schema/analysis/multidimensional/services/fonts/server">
<fon:Font
name="Arial"
caption="Arial"
resourceUrl="file://C:/WINDOWS/Fonts/ARIAL.TTF"
type="TrueType"
locale="en" />
<fon:Font
name="MS Mincho"
caption="MS Mincho"
resourceUrl="file://C:/WINDOWS/Fonts/MSMINCHO.TTC,0"
type="TrueTypeCollection"
locale="ja" />
<fon:Font
name="MingLiU"
caption="MingLiU"
resourceUrl="file://C:/WINDOWS/Fonts/mingliu.ttc,0"
type="TrueTypeCollection"
locale="zh" />
<fon:Font
name="Batang"
caption="Batang"
resourceUrl="file://C:/WINDOWS/Fonts/batang.ttc,0"
type="TrueTypeCollection"
locale="ko" />
</fon:ServerFonts>

Tip
---
If the font used to render charts does not match the expected font, ensure that the `name` property in the `fonts.xml` file is correct. If it does not match a font available on the font path of the operating system that the MDAS is running on, an internal default font is used to render charts.

Tip
---
If the font used to generate PDF documents does not match the expected font, ensure that the `resourceURL` property in the `fonts.xml` file is correct. If the URL is invalid, an internal default font is used to generate PDF documents. To confirm that the URL is invalid, you can check the MDAS logs for a `MalformedURLException` or a `FileNotFoundException`.
4.6 To configure the BI platform for Essbase OLAP connections

You must have access to the installation directory of the Oracle Essbase client to perform these steps. The client is not mandatory for connecting to Essbase servers after you perform these steps.

1. Navigate to `<ORACLE_ESSBASE_DIR>\JavaAPI\lib`, where `<ORACLE_ESSBASE_DIR>` is the location of the Oracle Essbase client installation (for example, C:\Hyperion\products\Essbase\EssbaseClient\JavaAPI\lib).

2. Copy the JAR files for the Essbase installation. The files differ depending on the version of Essbase. Refer to Oracle Essbase documentation to verify the names of the files.
   For example, for Essbase version 11.1.0, copy the following JAR files:
   - cpld14.jar
   - ess_es_server.jar
   - ess_japi.jar
   For Essbase version 11.1.2.0, copy the following JAR files:
   - cpld.jar
   - ojdl.jar
   - ess_es_server.jar
   - ess_japi.jar
   - log4.jar

   **Note**
   The log4.jar file is also used by SAP BusinessObjects Business Intelligence suite. To avoid a conflict between different versions, it is recommended that you copy the file from the BI platform directory, for example, C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\java\lib\external

3. For each machine that hosts an instance of the Multi-Dimensional Analysis Service, paste the JAR files to the following folder, where `<BOE_INSTALL_DIR>` is the file path for the installation directory (for example, C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0):
   - `<BOE_INSTALL_DIR>\java\pjs\services\MDAS\lib\mdas-external`

4. Open the Central Management Console and restart each Adaptive Processing Server that hosts an instance of the MDAS.

When you are creating OLAP connections in the CMC, Oracle Essbase is available in the Provider list.

**Related Information**

Creating OLAP data source connections [page 63]
4.7 Firewall port usage

This table lists the servers and port numbers used by Analysis:

Table 1:

<table>
<thead>
<tr>
<th>Servers</th>
<th>Port Requirements</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMS</td>
<td>CMS name server port</td>
<td>6400</td>
</tr>
<tr>
<td>Multi-Dimensional Analysis Service (MDAS)</td>
<td>MDAS request port</td>
<td>Auto-assign</td>
</tr>
<tr>
<td>Input FRS</td>
<td>Input FRS Request Port</td>
<td>Auto-assign</td>
</tr>
</tbody>
</table>

For more information, see the section “Securing the BI platform” in the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

4.8 Cloning Analysis server deployments

The Multi-Dimensional Analysis Service is hosted by an Adaptive Processing Server (APS). You can clone an existing APS, or create a new APS containing an MDAS and other services. You can also clone an entire distributed MDAS deployment. This can be useful, for example, if you’ve set up a test environment, and then want to transfer the test environment to production.

For details on how to clone Analysis servers and deployments, see the section “Server Administration” in the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

4.9 Settings for preloading hierarchy metadata

The `multidimensional.services.preload.metadata` parameter in the `mdas.properties` file allows you to specify whether metadata for SAP BW or SAP HANA hierarchies is preloaded.

By default, this parameter is set to `true`, and metadata is preloaded when a user connects to the data source in Analysis. If you set the parameter value to `false`, Analysis delays loading metadata until the user performs workflows that require the data, also known as lazy loading. This setting may improve performance in Analysis when connecting to data sources with many dimensions and hierarchies.

However, setting the parameter to `false` also affects the `Swap with` and `Pivot With` lists. Before a user can select a hierarchy in the `Swap with` and `Pivot With` lists, the user must expand the parent dimension of that hierarchy in the metadata explorer.

Related Information

Configuration files for the MDAS Server [page 57]
4.10 Prompt validation

The `multidimensional.services.variable.validation.enabled` property in the `mdas.properties` file allows you to enable or disable automatic validation of SAP BW and SAP HANA prompt values.

On Windows, `mdas.properties` is found at this location: `C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\java\pjs\services\MDAS\resources\com\businessobjects\multidimensional\services`

On UNIX, `mdas.properties` is found at this location: `<SAP BusinessObjects Business Intelligence platform installation directory>/sap_bobj/enterprise_xi40/java/pjs/services/MDAS/resources/com/businessobjects/multidimensional/services`

By default, the `multidimensional.services.variable.validation.enabled` property is set to `true`. With this setting, the prompt values specified in the Prompts dialog box are automatically validated as users enter them. If a prompt value is invalid, a red X icon appears next to the prompt and the user cannot connect to the data source. In some cases, automatic prompt validation may cause slower performance when connecting to a data source.

You can disable validation of prompt values by opening the `mdas.properties` file and setting the property to `false`:

```
multidimensional.services.variable.validation.enabled=false
```

In this case, performance may be improved when connecting to a data source with prompts. Prompt values are still validated when the user clicks OK to submit the values. Also, the Validate button appears in the Prompts dialog box. This button allows users to optionally validate all prompt values before clicking OK.

Related Information

Configuration files for the MDAS Server [page 57]

4.11 Displaying workspaces in quirks mode

If your users need to view Analysis workspaces embedded in the SAP Enterprise Portal using Internet Explorer 9 or greater, you must configure Analysis, edition for OLAP to run in quirks document mode.

Quirks mode is a method used by Internet Explorer to render certain web pages. In this release, Analysis runs in standards mode by default, which conforms to HTML5 standards.

However, the SAP Enterprise Portal uses quirks mode. With Internet Explorer 9 and greater, quirks mode and standards mode cannot both be used in the same window. To view an Analysis workspace that is embedded in the SAP Enterprise Portal using Internet Explorer 9 or greater, Analysis must be configured to run in quirks mode.
You can use one of two options for running Analysis workspaces in quirks mode:

- Setting all workspaces to run in quirks mode: When you set the global `opendoc.quirks.mode` property to `true`, all Analysis workspaces are rendered in quirks mode.
- Setting individual workspaces to run in quirks mode: The global `opendoc.quirks.mode` property must be set to `false`. You can add the `quirks=true&` parameter to the OpenDocument links for individual workspaces. When users view the workspaces with those links, the workspaces open in quirks mode. Otherwise, workspaces open in standards mode.

4.11.1 To set all workspaces to run in quirks mode

The `opendoc.quirks.mode` property allows you to set all Analysis workspaces to run in quirks mode.

1. Open the Central Configuration Manager and stop the Tomcat Web Application Server.
2. On the BI platform server, open the `mdaclient.properties` configuration file.
   
   By default, the file can be found at the following location:
   
   **On Windows:** `C:\Program Files (x86)\SAP BusinessObjects\tomcat\webapps\BOE\WEB-INF\config\default`
   
   **On UNIX:** `<BI platform install directory>/tomcat/webapps/BOE/WEB-INF/config/default`
3. Set the `opendoc.quirks.mode` property to `true`:
   
   ```
   opendoc.quirks.mode=true
   ```
4. Save and close the `mdaclient.properties` file.
5. In the Central Control Manager, start the Tomcat Web Application Server.

After this change, users can view all Analysis workspaces that are embedded in the SAP Enterprise Portal, or another application that run in quirks mode.

If users open an Analysis workspace in a separate window or tab, or in an application that runs in standards mode, the following message appears:

The application was stopped due to a critical rendering error The IE compatibility view is not supported (Note 1586993).

After clicking *Ignore*, users can successfully view the workspace.

4.11.2 To set individual workspaces to run in quirks mode

When you add the `quirks=true&` parameter to an OpenDocument link for an Analysis workspace, that link can be used to embed the workspace in an application that runs in quirks mode, such as the SAP Enterprise Portal.

1. On the *Content Administration* tab of the SAP Enterprise Portal, open the iView template for the appropriate workspace.
2. In the *Show Category* list, select *SAP BusinessObjects*.
3. On the *Application Parameters* row, type `quirks=true&` into the *Value* column.
4. Save and close the iView template.

4.12 Export limit

To prevent excessively large exports to Excel, CSV, and PDF, the default export limit is set to 100,000 data values. Depending on the amount of memory used by the MDAS, it is possible to safely increase this value if the default limit is insufficient. The value can be changed by modifying the following property in the file `mdas.properties`:

```
multidimensional.services.export.cells.limit=100000
```

- **On Windows**, `mdas.properties` is found at this location:
  
  C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\java\pjs\services\MDAS\resources\com\businessobjects\multidimensional\services

- **On UNIX**, `mdas.properties` is found at this location:
  
  `<SAP BusinessObjects Business Intelligence platform installation directory>)/sap_bobj/enterprise_xi40/java/pjs/services/MDAS/resources/com/businessobjects/multidimensional/services`

4.13 Member selector cache limit

When working with large lists of values in Analysis, performance may be slow when the Member Selector dialog box is opened. For better performance with large lists of values, you can increase the setting for the `multidimensional.services.member.selector.cache.limit` property in the `mdas.properties` file:

```
multidimensional.services.member.selector.cache.limit=2000
```

- **On Windows**, `mdas.properties` is found at this location:
  
  C:\Program Files (x86)\SAP BusinessObjects \SAP BusinessObjects Enterprise XI 4.0\java\pjs\services\MDAS\resources\com \businessobjects\multidimensional\services

- **On UNIX**, `mdas.properties` is found at this location:
  
  `<SAP BusinessObjects Business Intelligence platform installation directory>)/sap_bobj/enterprise_xi40/java/pjs/services/MDAS/ resources/com/businessobjects/multidimensional/services`

By default, the `multidimensional.services.member.selector.cache.limit` property is set to 2000. With this setting, if there are 2000 or fewer members in the Member Selector dialog box, the members are cached in the MDAS for better performance. You can increase this setting to raise the number of members that can be cached. The property applies only to flat characteristics.

**Note**

The `multidimensional.services.member.selector.cache.limit` setting cannot exceed the **Maximum number of members returned when filtering** setting in the Central Management Console. For best performance, it is recommended to set the **Maximum number of members returned when filtering** setting to 5000 or lower.
4.14 Session timeout settings

Client-side timeout settings

Because the Analysis client runs within the BI launch pad, which runs within the web server container, always ensure that the web server timeout is greater than or equal to the BI launch pad timeout.

In the `web.xml` files, locate the following XML block and change the timeout values (in minutes) as desired:

```xml
<session-config>
  <session-timeout>20</session-timeout>
</session-config>
```

Your changes will take effect after you delete the old web server work directory and restart the web server.

- On Windows (assuming that your deployment uses the Tomcat web server), the client-side timeout settings are stored in these files:
  - Web server: `C:\Program Files (x86)\SAP BusinessObjects\tomcat\conf\web.xml`
    The session timeout setting is located in the Default Session Configuration section.
  - BI launch pad: `C:\Program Files (x86)\SAP BusinessObjects\tomcat\webapps\BOE\WEB-INF\web.xml`

- On UNIX (assuming that your deployment uses the Tomcat web server) the client-side timeout settings are stored in these files:
  - Web server: `<SAP BusinessObjects Business Intelligence platform installation directory>/sap_bobj/tomcat/conf/web.xml`
    The session timeout setting is located in the Default Session Configuration section.
  - BI launch pad: `<SAP BusinessObjects Business Intelligence platform installation directory>/sap_bobj/tomcat/webapps/BOE/WEB-INF/web.xml`

Server-side timeout setting

Ensure that the server-side timeout value is greater than the client-side timeout value.

- On Windows, the server-side timeout setting is stored in this file: `C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\java\pjs\services\MDAS\resources\com\businessobjects\multidimensional\services\mdas.properties`

- On UNIX, the server-side timeout setting is stored in this file: `<SAP BusinessObjects Business Intelligence platform installation directory>/sap_bobj/enterprise_xi40/java/pjs/services/MDAS/resources/com/businessobjects/multidimensional/services/mdas.properties`
4.15 Accessibility

Analysis provides an accessibility mode for users with visual or motor impairments. For information on how to turn on accessibility mode, see the Analysis User Guide.

4.16 SAP Notes required

Updates when using SAP BW data sources

For best performance when using SAP BW data sources, refer to SAP Note 1498007, which details required updates for your system. These updates resolve several known issues and add new capabilities, such as case-insensitive search in the Analysis client.

"Show levels" and "Create favorite filter"

"Show levels" and "Create favorite filter" are available only on BW server 7.0.1 and above for performance reasons.

For SAP BW 7.0.1 SP3 or SP4, SAP note 1436426 is required.

4.17 Oracle OLAP Data Provider for SAP BusinessObjects Business Intelligence

The Oracle OLAP Data Provider connects Analysis directly to your Oracle OLAP database, enabling powerful query and analysis of your multi-dimensional data. This mid-tier data provider processes XMLA requests from Analysis and retrieves data from the Oracle OLAP database.

The following section describes how to install and configure the Oracle OLAP Data Provider on computers running Windows or Linux operating systems and one of the supported web application servers: JBoss Application Server or Apache Tomcat.

After you install the provider and enable Oracle OLAP data sources for the BI platform, you can create connections to Oracle OLAP data source in the Central Management Console.

For more information about installing, configuring, and troubleshooting the Oracle OLAP database that you want to connect to, see the Simba XMLA for Oracle OLAP: Administrator Guide available at http://www.simba.com/resources/product-documentation.
4.17.1 Software requirements for the Oracle OLAP Data Provider

The following software is required to install the Oracle OLAP Data Provider:

- Windows Server 2008 R2 Service Pack 1 or SUSE Linux Enterprise Server 11 (x86_64) Service Pack 2
- Oracle Instant Client ODBC Driver Version 11.2 (64-bit)
- Java SE Development Kit (JDK) 6 Update 35 or later (64-bit)
- JBoss Application Server 7.1.1 or Apache Tomcat 7.0.37 or later

Note
Both JBoss and Tomcat require that you install a JDK, instead of a Java Runtime Environment (JRE).

4.17.1.1 To install the ODBC driver

The Oracle OLAP Data Provider communicates with the database using an Open Database Connectivity (ODBC) interface. The recommended driver is the 64-bit Oracle Instant Client Version 11.2.

Note
The Oracle OLAP Data Provider uses 64-bit architecture, so the ODBC driver must use 64-bit architecture as well.

1. In a web browser, navigate to the following URL:
   - For Windows: http://www.oracle.com/technetwork/topics/winx64soft-089540.html
   - For Linux: http://www.oracle.com/technetwork/topics/linuxx86-64soft-092277.html

2. Download the latest versions of the Instant Client Package - Basic and the Instant Client Package - ODBC.

3. Open the readme file in the Instant Client Package - ODBC package and follow the instructions to install the Oracle ODBC Instant Client.

   In the Windows package, the readme file is ODBC_IC_Readme_Win.html. In the Linux package, the file is ODBC_IC_Readme_Unix.html.

After installing the Oracle ODBC Instant Client, you must add a DSN for the Oracle database that you want to connect to in Analysis, and configure environment variables.

For information on using unixODBC, see http://www.unixodbc.org/.
4.17.1.2 To create an Oracle ODBC driver Data Source Name (DSN)

For Windows, follow this procedure to create a DSN for the Oracle database. For Linux, you must use the odbc_update_ini.sh file to create a DSN. For more information, refer to the documentation included in the Oracle ODBC Instant Client installation package.

1. Open the ODBC Data Source Administrator dialog box. For example, click Start ➔ Control Panel ➔ Administrative Tools ➔ Data Sources (ODBC).
2. Click the System DSN tab.
3. Click Add.
4. In the Create New Data Source dialog box, click Oracle in instantclient_11_2 and click Finish.
5. In the Oracle ODBC Driver Configuration dialog box, enter the following information:
   - **Data Source Name**: Type a name for the data source.
   - **Description**: Optionally, type a description for the data source.
   - **TNS Service Name**: Type `<host>:<port>/<SID>`, where `<host>` is the service name or IP address that the database connects to, `<port>` is the port where the database is listening, and `<SID>` is the unique name of the database instance. For example, 192.168.100.101:1521/ORCL or dbhost:1521/ORCL. Alternatively, you can click the arrow to the right of the field and select the database service name for the appropriate Oracle server.
   - **User ID**: Type the username that you use to log on to the Oracle database.
6. Click Test Connection.
7. In the Oracle ODBC Driver Connect dialog box, in the Password field, type the password for the username that you use to log on to the Oracle database. Click OK.
8. If the connection is successful, in the Oracle ODBC Driver Configuration dialog box, click OK.

**Note**
If the connection fails, verify the settings you provided for the DSN.

4.17.2 Oracle OLAP Data Provider installation package

The Oracle OLAP Data Provider is delivered in the following zip file, where `<Version>` is the version number of the provider:
- For Windows: M4OXmlaWebService_<Version>_windows.zip
- For Linux: M4OXmlaWebService_<Version>_linux.zip

The archive contains the following files:
- M4OXmlaWebService.war
  This file is a Web Archive File—a compressed archive used to distribute web applications.
- M4OXmlaWebService.war.dodeploy
  This file is an empty text file that indicates to JBoss to deploy the M4OXmlaWebService.war web application. This file is not used when installing the web service on Tomcat.
4.17.2.1 To install the Oracle OLAP Data Provider using JBoss

1. On the machine where you want to install the Oracle OLAP Data Provider, navigate to the deployments folder in your JBoss installation and ensure that a webapps folder exists there. For example, C:\Program Files (x86)\jboss-as-7.1.1.Final\standalone\deployments\webapps. Create a webapps folder if it does not already exist.
2. In the webapps folder, create a folder called M4OXmlaWebService.war.
3. Open the installation package and extract the M4OXmlaWebService.war archive.
4. Rename the M4OXmlaWebService.war archive file to M4OXmlaWebService.zip and then extract the contents of the M4OXmlaWebService.zip archive to the standalone\deployments\webapps M4OXmlaWebService.war folder.
5. Open the installation package and extract the sxo folder and its contents. 
   ○ For Windows, extract the sxo folder to the root directory on the drive from which the computer boots Windows (typically C:\).
   ○ For Linux, in the /etc folder, create a folder named mdxprovider and extract the sxo folder to /etc/mdxprovider. Then, in the /etc/mdxprovider/sxo folder, create a folder named logs.

4.17.2.2 To install the Oracle OLAP Data Provider using Apache Tomcat

1. On the machine where you want to install the Oracle OLAP Data Provider, open the installation package and extract the M4OXmlaWebService.war archive file to the webapps folder of your Tomcat installation. For example, C:\Program Files (x86)\SAP BusinessObjects\tomcat\webapps.
2. Open the installation package and extract the sxo folder and its contents.
   ○ For Windows, extract the sxo folder to the root directory on the drive from which the computer boots Windows (typically C:\).
   ○ For Linux, in the /etc folder, create a folder named mdxprovider and extract the sxo folder to /etc/mdxprovider.
4.17.2.3 To upgrade an existing installation of the Oracle OLAP Data Provider

Follow these steps to upgrade from version 2.0.0.1 or higher to the latest version of the Oracle OLAP Data Provider.

1. Stop your web server.
2. In the webapps folder where you installed the Oracle OLAP Data Provider, delete any of the following files or folders that exist:
   ○ M4OXmlaWebService.war
   ○ M4OXmlaWebService.war.deployed
   ○ M4OXmlaWebService
3. Rename the sxo folder to sxo_old.
   For Windows, this folder is typically located at C:\sxo. For Linux, its location is etc\mdxprovider\sxo.
4. Follow the appropriate procedure to install the latest version of the Oracle OLAP Data Provider.
5. Update the DataSources.xml file in the sxo folder based on the settings in the DataSources.xml file in the sxo_old folder.
   You can delete the sxo_old folder after carrying out this step.
6. If you did not extract the sxo folder to the default location, you must configure the xmla.properties file again.
7. Start your web server.

Related Information

Running the web server and XMLA service [page 35]
To install the Oracle OLAP Data Provider using JBoss [page 29]
To install the Oracle OLAP Data Provider using Apache Tomcat [page 29]
To configure the DataSources.xml file [page 31]
To configure the xmla.properties file [page 31]

4.17.3 Configuring the Oracle OLAP Data Provider

To configure the Oracle OLAP Data Provider for SAP BusinessObjects Business Intelligence, you must specify several settings:

- Data source settings
- XMLA service properties
- Environment variables
- Memory options
4.17.3.1 To configure the DataSources.xml file

The DataSources.xml file specifies the data source name (DSN) that the Oracle OLAP Data Provider uses.

1. In a text editor, open the DataSources.xml file located in the sxo folder.
2. In the <DataSourceName> element, type a name for the data source.
3. In the <DataSourceDescription> element, type any relevant details about the data source.
4. In the <DataSourceInfo> element, provide the connection string for the data source using the following syntax:

   `<DataSourceInfo>Data Source=<DataSourceName>;UserID=<UserID>;Password=<Password></DataSourceInfo>`

   In this example, <DataSourceName> is the name of the Oracle ODBC driver data source that you created for the data provider, <UserID> is the user name that you use to connect to the database, and <Password> is the password that corresponds to the user name.

   **i Note**
   It is not necessary to provide the user ID and password, because these credentials will be provided when creating a connection from Analysis to the database.

5. In the <URL> element, type the URL to the Oracle OLAP Data Provider virtual folder to indicate how the web server will access the service’s deployed files. For example, if your web server installation uses the default port and you bind it to the default IP address 127.0.0.1, type the following URL: `<URL>http://localhost:8080/M4OXmlaWebService/</URL>`

   **i Note**
   The IP address depends on the settings of your web server.

6. Save and close the DataSources.xml file.

   If you configure the Oracle OLAP Data Provider when the XMLA service is running, then you must stop and start the service to apply changes.

**Related Information**

[Running the web server and XMLA service](page 35)

4.17.3.2 To configure the xmla.properties file

If you do not install the Oracle OLAP Data Provider in the default location, you must configure the xmla.properties file.

1. Navigate to the folder where you extracted the M4OXmlaWebService.war archive file to install the Oracle OLAP Data Provider.
2. From this folder, open the file `M4OXmlaWebService.war\WEBINF\classes\com\customer\xmla.properties` in a text editor.

3. Set the `DatasourcesURI` property to the absolute path of the `DataSources.xml` file.
   - For example, in Linux: `DatasourcesURI=/etc/mdxprovider/sxo/DataSources.xml`
   - For Windows, use Uniform Resource Identifier (URI) syntax. For example: `DatasourcesURI=sxo//sources.xml`

   - For example, in Linux: `DatasetSchemaURI=/etc/mdxprovider/sxo/DatasetSchema.xml`
   - For Windows, use URI syntax. For example: `DatasetSchemaURI=sxo/DatasetSchema.xml`

5. Save and close the `xmla.properties` file.

4.17.3.3 Configuring environment variables

You must set environment variables to specify the folder where the Java Development Kit is installed, and where JBoss or Tomcat is installed.

> Remember

For changes to environment variables to take effect, you must log out of the operating system, and then log in again.

4.17.3.3.1 Configuring environment variables for Windows

4.17.3.3.1.1 To set the JAVA_HOME environment variable for Windows

1. Open the `System Properties` dialog box. For example, click `Start > Control Panel > System and Security > System`, and then click `Advanced system settings`.
2. In the `System Properties` dialog box, click the `Advanced` tab, and then click `Environment Variables`.
3. In the `System Variables` area, configure the `JAVA_HOME` variable.
   - If the `JAVA_HOME` variable does not exist, then click `New`. In the `New System Variable` dialog box, type `JAVA_HOME` in the `Variable Name` field. In the `Variable Value` field, type the path to the root folder of the Java Development Kit installation on the computer. For example, the path may be `C:\Program Files\Java\jdk1.6.0_37`. Click `OK`.

   > Note

   Do not set the value of the `JAVA_HOME` environment variable to the path of the `/bin` subfolder.
   - If the `JAVA_HOME` variable exists, then ensure that variable value is correctly set as the path to the root folder of the JDK installation on the computer.
4.17.3.3.1.2 To set the JBOSS_HOME environment variable for Windows

If you are using the JBoss Application Server on a Windows operating system, follow these steps to set the JBOSS_HOME environment variable to specify the folder where JBoss is installed.

1. Open the System Properties dialog box. For example, click Start ➤ Control Panel ➤ System and Security ➤ System ➤ Advanced system settings.
2. In the System Properties dialog box, click the Advanced tab, and then click Environment Variables.
3. In the System Variables area, configure the JBOSS_HOME variable.
   - if the JBOSS_HOME variable does not exist, then click New. In the New System Variable dialog box, type JBOSS_HOME in the Variable Name field. In the Variable Value field, type the path to the root folder of the JBoss Application Server installation on the computer. Click OK.
   - If the JBOSS_HOME variable exists, then ensure that variable value is correctly set as the path to the root folder of the JBoss installation on the computer.

4.17.3.3.1.3 To set the CATALINA_HOME environment variable for Windows

If you are using Tomcat on a Windows operating system, follow these steps to set the CATALINA_HOME environment variable to specify the folder where Tomcat is installed.

1. Open the System Properties dialog box. For example, click Start ➤ Control Panel ➤ System and Security ➤ System ➤ Advanced system settings.
2. In the System Properties dialog box, click the Advanced tab, and then click Environment Variables.
3. In the System Variables area, configure the CATALINA_HOME variable.
   - if the CATALINA_HOME variable does not exist, then click New. In the New System Variable dialog box, type CATALINA_HOME in the Variable Name field. In the Variable Value field, type the path to the root folder of the Tomcat installation on the computer. Click OK.
   - If the CATALINA_HOME variable exists, then ensure that variable value is correctly set as the path to the root folder of the Tomcat installation on the computer.

4.17.3.3.2 Configuring environment variables for Linux

4.17.3.3.2.1 To set the JAVA_HOME environment variable for Linux

1. In a text editor, open the following file: /etc/profile.local
If the file /etc/profile.local does not exist, then create the file.

2. In the profile.local file, add the following line:

   ```
   export JAVA_HOME="<JDKRootFolder>"
   ```

   `<JDKRootFolder>` represents the path to the root folder of the Java Development Kit installation on the computer. For example, the path may be /usr/java/jdk1.7.0_17.

   **Note**

   Do not set the value of the JAVA_HOME environment variable to the path of the /bin subfolder.

3. Save and close the profile.local file.

### 4.17.3.3.2.2 To set the JBOSS_HOME environment variable for Linux

If you are using the JBoss Application Server on a Linux operating system, follow these steps to set the JBOSS_HOME environment variable to specify the folder where JBoss is installed.

1. In a text editor, open the following file: /etc/profile.local
2. In the profile.local file, add the following line:

   ```
   export JBOSS_HOME="<JBossRootFolder>"
   ```

   `<JBossRootFolder>` represents the path to the root folder of the JBoss installation on the computer.

3. Save and close the profile.local file.

### 4.17.3.3.2.3 To set the CATALINA_HOME environment variable for Linux

If you are using Tomcat on a Linux operating system, follow these steps to set the CATALINA_HOME environment variable to specify the folder where Tomcat is installed.

1. In a text editor, open the following file: /etc/profile.local
2. In the profile.local file, add the following line:

   ```
   export CATALINA_HOME="<TomcatRootFolder>"
   ```

   `<TomcatRootFolder>` represents the path to the root folder of the Tomcat installation on the computer.

3. Save and close the profile.local file.
### 4.17.4 Configuring JVM memory usage

You must set the following parameters to allocate memory for your web server Java Virtual Machine (JVM):

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Xms64M</td>
<td>Set the minimum memory requirement to 64MB of heap space.</td>
</tr>
<tr>
<td>-Xmx4096M</td>
<td>Set the maximum heap size to 4 GB.</td>
</tr>
<tr>
<td>-XX:MaxPermSize=512M</td>
<td>Set the maximum permanent generation memory to 512 MB.</td>
</tr>
<tr>
<td>-Xss256k</td>
<td>Set the maximum stack frame size to 256 KB.</td>
</tr>
</tbody>
</table>

The steps to set these parameters depend on your web server.

#### 4.17.4.1 To set JVM memory usage for JBoss

1. In a text editor, open the file `standalone.conf.bat` in the `bin` folder of your JBoss installation. For Linux, the file is named `standalone.conf`.
2. Add or update the line of code defining the `JAVA_OPTS` variable to set the appropriate memory usage parameters.
   For example, add the following line:
   
   ```
   set "JAVA_OPTS=-Xms64M -Xmx4096M -XX:MaxPermSize=512M -Xss256k"
   ```
3. Save and close the `standalone.conf.bat` file.

#### 4.17.4.2 To set JVM memory usage for Tomcat

1. In a text editor, open the file `startup.bat` in the `bin` folder of your Tomcat installation. For Linux, the file is named `startup.sh`.
2. Add or update the line of code defining the `CATALINA_OPTS` variable to set the appropriate memory usage parameters.
   For example, add the following line:
   
   ```
   set "CATALINA_OPTS=-Xms64M -Xmx4096M -XX:MaxPermSize=512M -Xss256k"
   ```
3. Save and close the `startup.bat` file.

### 4.17.5 Running the web server and XMLA service

During testing, you can start and stop the Oracle OLAP Data Provider by starting and stopping your web server using the command line. In a production system, administering your web server using the tools that the web server provides allows you to administer the Oracle OLAP Data Provider without stopping the web server.
Refer to the documentation for your web server for more detailed information:

- For information about administering JBoss Application Server 7.1.1, see JBoss documentation at https://docs.jboss.org/author/display/AS71/Documentation
- For information about administering Tomcat, see http://tomcat.apache.org/tomcat-7.0-doc/

4.17.5.1 Starting and stopping JBoss for Windows

4.17.5.1.1 To start JBoss for Windows

1. Open a new Command Prompt window. For example, click Start > All Programs > Accessories, right-click Command Prompt, and click Run as administrator.

   **Note**
   You must open a new Command Prompt window to recognize any changes to environment variables that you made while configuring the Oracle OLAP Data Provider.

2. In the Command Prompt window, browse to the root folder where JBoss is installed.

3. Type `cd bin` and press Enter.

4. Type `standalone.bat` and press Enter.

   **Note**
   Running `standalone.bat` without any parameters binds JBoss to the localhost IP address 127.0.0.1. As a result, the XMLA service is not accessible from remote computers. For testing purposes, you can start JBoss by typing `standalone.bat -b 0.0.0.0` to bind to all IP addresses, making the XMLA service accessible from all remote computers. Binding JBoss to all IP addresses is not recommended for production systems due to a lack of security. See JBoss documentation for more information.

Typically, JBoss starts within 30 seconds.

4.17.5.1.2 To stop JBoss for Windows

1. Select the Command Prompt window where you started JBoss and press Ctrl + C.

2. When prompted to terminate the batch job, type y, and then press Enter.
4.17.5.2 Starting and stopping JBoss for Linux

4.17.5.2.1 To start JBoss for Linux

Execute the following command as root user:

```
$JBOSS_HOME/bin/standalone.sh
```

**Note**

Running `standalone.sh` without any parameters binds JBoss to the localhost IP address 127.0.0.1. As a result, the XMLA service is not accessible from remote computers. For testing purposes, you can start JBoss by typing `standalone.sh -b 0.0.0.0` to bind to all IP addresses, making the XMLA service accessible from all remote computers. Binding JBoss to all IP addresses is not recommended for production systems due to a lack of security. See JBoss documentation for more information.

Typically, JBoss starts within 30 seconds.

4.17.5.2.2 To stop JBoss for Linux

In the Terminal window where you started JBoss, press Ctrl + C.

You can also execute the following command to stop JBoss:

```
$JBOSS_HOME/bin/jboss-cli.sh --connect --command=:shutdown
```

4.17.5.3 Starting and stopping Tomcat for Windows

4.17.5.3.1 To start Tomcat for Windows

This procedure assumes that you did not use the Windows Service Installer to install Tomcat. If you installed Tomcat using the Windows Service Installer, then use the graphical user interface (GUI) to start Tomcat.

1. Open a new Command Prompt window. For example, click Start ➤ All Programs ➤ Accessories ➤ right-click Command Prompt, and click Run as administrator.

   **Note**

   You must open a new Command Prompt window to recognize any changes to environment variables that you made while configuring the Oracle OLAP Data Provider.

2. In the Command Prompt window, browse to the root folder where JBoss is installed.
3. Type `cd bin` and press Enter.
4. Type `startup.bat` and press Enter.
4.17.5.3.2 To stop Tomcat for Windows

This procedure assumes that you did not use the Windows Service Installer to install Tomcat. If you installed Tomcat using the Windows Service Installer, then use the graphical user interface (GUI) to stop Tomcat.

In the Command Prompt window where you started Tomcat, type `shutdown.bat` and press Enter.

4.17.5.4 Starting and stopping Tomcat for Linux

4.17.5.4.1 To start Tomcat for Linux

Execute the following command as root user:

```bash
$CATALINA_HOME/bin/startup.sh
```

**Note**

By default, Tomcat binds to all IP addresses. Binding Tomcat to all IP addresses is not recommended for production systems due to the lack of security. See [http://tomcat.apache.org/tomcat-7.0-doc/config/index.html](http://tomcat.apache.org/tomcat-7.0-doc/config/index.html) for more details on Apache Tomcat server configuration.

4.17.5.4.2 To stop Tomcat for Linux

Execute the following command as root user:

```bash
$CATALINA_HOME/bin/shutdown.sh
```

4.17.6 Testing your installation

You can test your installation to confirm that the web server and the XMLA service are running.
Testing your web server

After you start your web server, you can confirm that it runs by using a web browser to navigate to a URL with the following structure: http://<IP Address>:<port>, where <IP Address> is the IP address that the web server is bound to, and <port> is the port where the web server is listening.

For example, if your web server uses the default port and you bound the web server to the IP address 127.0.0.1, then type http://localhost:8080/

If your web server is successfully installed, the browser displays a page informing you that the web server is running.

Testing the XMLA service

If your web server is running, you can confirm that the XMLA service is running by navigating to a URL with the following structure: http://<IP Address>:<port>/M40XmlaWebService/, where <IP Address> and <port> have the same values that you used to test the web server.

The final slash character (/) is required.

If the web server successfully deployed the XMLA service, then the browser displays the XMLA service start page that lists Execute and Discover methods under the heading XmlaWebService.

4.17.7 Using JConsole to monitor the Oracle OLAP Data Provider

The JConsole monitoring tool provides information about the performance and resource consumption of applications running on the Java platform.

For more details, refer to the documentation for your web server or for your JDK.

4.17.7.1 To monitor attributes on JBoss

JBoss provides a version of JConsole that clients can use to monitor the XMLA service. To monitor the XMLA service on JBoss, you must use this version of JConsole. Do not use the JConsole tool provided with the JDK.

Each client monitoring the XMLA service must have JBoss installed on the local computer. Also, be sure to start JConsole by running jconsole.bat or jconsole.sh so that the correct class paths are constructed.

1. Using a Terminal window for Linux or a Command Prompt window for Windows, browse to the bin folder of your JBoss installation.
2. Type the following command and then press Enter:
   ○ For Windows: jconsole.bat
For Linux: `sh jconsole.sh`

3. In the **JConsole: New Connection** dialog box, select **Remote Process**.

4. In the field below the **Remote Process** radio button, type a URL with the following structure:
   ```
   service:jmx:remotingjmx://<Host>:<Port>,
   ```
   where `<Host>` is the IP address of the computer running JBoss and `<Port>` is the port where the JBoss native management interface is listening. By default, the port is 9999.

5. In the **Username** field, type the username for logging into the JMX agent.

6. In the **Password** field, type the password corresponding to the username.

7. Click **Connect**.

8. In the **Java Monitoring & Management Console** window, click **MBeans**.

9. In the left pane, click `[MDX Provider for Oracle XMLA » XMLA » Attributes]`.

10. Select an attribute to view the attribute details.

### 4.17.7.2 To monitor attributes on Tomcat

Clients can use the JConsole tool provided with the JDK to monitor the XMLA service on Tomcat.

Each client monitoring the XMLA service must have the JDK installed on the local computer.

1. Using a Terminal window for Linux or a Command Prompt window for Windows, browse to the `bin` folder of your JDK installation.

2. Type the following command and then press **Enter**:
   
   - For Windows: `jconsole.exe`
   - For Linux: `jconsole`

3. In the **JConsole: New Connection** dialog box, select **Remote Process**.

4. In the field below the **Remote Process** radio button, type a URL with the following structure: `<Host>:<Port>`, where `<Host>` is the IP address of the computer running Tomcat and `<Port>` is the port configured for monitoring.

5. In the **Username** field, type the username for logging into the JMX agent.

6. In the **Password** field, type the password corresponding to the username.

7. Click **Connect**.

8. In the **Java Monitoring & Management Console** window, click **MBeans**.

9. In the left pane, click `[MDX Provider for Oracle XMLA » XMLA » Attributes]`.

10. Select an attribute to view the attribute details.

### 4.17.7.3 JConsole attribute reference

The following table lists the attributes that JConsole monitors for the Oracle OLAP Data Provider:

---
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentSessionCount</td>
<td>The total number of sessions currently open.</td>
</tr>
<tr>
<td>TotalSessionCreated</td>
<td>The total number of sessions created since users connected to the data source.</td>
</tr>
<tr>
<td>CellDataQueryCount</td>
<td>The total number of queries accessing business data.</td>
</tr>
<tr>
<td>CellDataQueryAvgSecond</td>
<td>The average period of time, in seconds, spent executing a cell data query.</td>
</tr>
<tr>
<td>CellDataQueryMaxSecond</td>
<td>The longest period of time, in seconds, spent executing a cell data query.</td>
</tr>
<tr>
<td>ConnectionQueryCount</td>
<td>The total number of queries related to security, user accounts and the connection process.</td>
</tr>
<tr>
<td>ConnectionQueryAvgSecond</td>
<td>The average period of time, in seconds, spent executing a connection query.</td>
</tr>
<tr>
<td>ConnectionQueryMaxSecond</td>
<td>The longest period of time, in seconds, spent executing a connection query.</td>
</tr>
<tr>
<td>DrillThroughQueryCount</td>
<td>The total number of queries accessing data aggregated for a measure.</td>
</tr>
<tr>
<td>DrillThroughQueryAvgSecond</td>
<td>The average period of time, in seconds, spent executing a drill through query.</td>
</tr>
<tr>
<td>DrillThroughQueryMaxSecond</td>
<td>The longest period of time, in seconds, spent executing a drill through query.</td>
</tr>
<tr>
<td>MetaDataQueryCount</td>
<td>The total number of queries to data in the Business Intelligence repository.</td>
</tr>
<tr>
<td>MetaDataQueryAvgSecond</td>
<td>The average period of time, in seconds, spent executing a metadata query.</td>
</tr>
<tr>
<td>MetaDataQueryMaxSecond</td>
<td>The longest period of time, in seconds, spent executing a metadata query.</td>
</tr>
<tr>
<td>TotalQueryCount</td>
<td>The total number of all queries processed since the installation of the Oracle OLAP Data Provider.</td>
</tr>
<tr>
<td>TotalQueryAvgSecond</td>
<td>The average period of time, in seconds, spent executing a query.</td>
</tr>
<tr>
<td>TotalQueryMaxSecond</td>
<td>The longest period of time, in seconds, spent executing a query.</td>
</tr>
</tbody>
</table>
### Attribute Description

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XmlaExecuteCount</td>
<td>The total number of the times that the XMLA Execute function has been called.</td>
</tr>
<tr>
<td>XmlaExecuteAvgSecond</td>
<td>The average period of time, in seconds, spent by the XMLA Execute function.</td>
</tr>
</tbody>
</table>

### 4.17.8 To enable the Oracle OLAP Data Provider for Analysis

You must set a property in the *mdas_oda.properties* file of your BI platform installation to create data source connections to Oracle OLAP databases.

1. Open the following file, where `<install_dir>` is the root installation folder of the BI platform:
   
   `<install_dir>\SAP BusinessObjects Enterprise XI 4.0\java\pjs\services\MDAS\resources\com\businessobjects\multidimensional\services\mdas_oda.properties`

2. Ensure that the property setting for Oracle OLAP is set to true:
   
   `ENABLE_ORACLE_OLAP = true`

3. Save and close the file.

4. Open the Central Management Console and restart each Adaptive Processing Server that hosts an instance of the MDAS.

*Oracle OLAP* appears as an option in the *Provider* list when you are working with OLAP data source connections in the CMC. You can now create OLAP data source connections to your Oracle OLAP server.

### Related Information

- [Creating OLAP data source connections](#) [page 63]
- [Connection settings for Oracle OLAP data sources](#) [page 80]

### 4.17.9 Uninstalling the Oracle OLAP Data Provider

#### 4.17.9.1 To uninstall the Oracle OLAP Data Provider for Windows

1. If no web services are running other than the Oracle OLAP Data Provider, then stop the web server.

2. Open the *ODBC Data Source Administrator* dialog box. For example, click `Start ➔ Control Panel ➔ Administrative Tools ➔ Data Sources (ODBC) ➔`

3. Click the *System DSN* tab.
4. Select the DSN that you created for the Oracle OLAP Data Provider to connect to the database, and click Remove.
5. Click OK.
6. In the root directory on the drive from which the computer boots Windows (typically C:\), delete the sxo folder.
7. Delete the following files and folders:
   ○ For JBoss, delete M4OXmlaWebService.war and M4OXmlaWebService.war.deployed from the \standalone\deployments\webapps\ folder of your JBoss installation.
   ○ For Tomcat, delete M4OXmlaWebService.war and the M4OXmlaWebService folder from the \webapps\ folder of your Tomcat installation.

Related Information

Running the web server and XMLA service [page 35]

4.17.9.2 To uninstall the Oracle OLAP Data Provider for Linux

1. If no web services are running other than the Oracle OLAP Data Provider, then stop the web server.
2. Remove the DSN that you created for the Oracle OLAP Data Provider to connect to the database.
3. Delete the folder /etc/mdxprovider.
4. Delete the following files and folders:
   ○ For JBoss, delete M4OXmlaWebService.war and M4OXmlaWebService.war.deployed from the /standalone/deployments/webapps folder of your JBoss installation.
   ○ For Tomcat, delete M4OXmlaWebService.war and the M4OXmlaWebService folder from the /webapps folder of your Tomcat installation.

Related Information

Running the web server and XMLA service [page 35]

4.17.10 Using logging to troubleshoot MDX and SQL issues

When error messages do not provide enough information to troubleshoot an issue, it may be necessary to turn on logging in the Oracle OLAP Data Provider. After logging is enabled, repeat the steps that are causing the error.
Note

Only enable logging long enough to capture the problem. Logging slows down the data provider and can consume a large quantity of disk space.

4.17.10.1 To turn on logging for Windows

Before carrying out this procedure, stop the MDAS and the Oracle OLAP Data Provider.

1. In the Oracle OLAP Data Provider installation package, navigate to the \Utils\Logging subfolder and double-click the registry file named Windows_Logging_On.reg.

   The Windows_Logging_On.reg file contains the path where the log files will be saved. By default, the path is C:\Logs. To change the path, open the file in a text editor and update the value for "Path". Backslash characters (\) must be escaped with a second backslash.

   For example:

   "PATH"="C:\Users\Administrator"

2. Restart the Oracle OLAP Data Provider.
3. Restart the MDAS.

   The log files are saved with filenames like OracleMdxProvider.<timestamp>.log. Log files are automatically split into 5MB files, so there may be a number of consecutive files.

4.17.10.2 To turn off logging for Windows

Before carrying out this procedure, stop the MDAS and the Oracle OLAP Data Provider.

1. In the Oracle OLAP Data Provider installation package, navigate to the \Utils\Logging subfolder and double-click the registry file named Windows_Logging_Off.reg.
2. Restart the Oracle OLAP Data Provider.
3. Restart the MDAS.

4.17.10.3 To turn on logging for Linux

Before carrying out this procedure, stop the MDAS and the Oracle OLAP Data Provider.

1. In a text editor, open the configuration file /etc/mdxprovider/sxo/tracesettings.conf

   This configuration file sets the path where the log files will be saved. The default path is /etc/mdxprovider/sxo/logs. To change the path, update the value for the line in the configuration file that starts with LogEx.LogWriter.LogFile.Path=
2. Change the line `LogEx.Enabled=false` to `LogEx.Enabled=true` and save the file.
3. Restart the Oracle OLAP Data Provider.
4. Restart the MDAS.

The log files are saved with filenames like `OracleMdxProvider.<timestamp>.log`. Log files are automatically split into 5MB files, so there may be a number of consecutive files.

### 4.17.10.4 To turn off logging for Linux

Before carrying out this procedure, stop the MDAS and the Oracle OLAP Data Provider.

1. In a text editor, open the configuration file `/etc/mdxprovider/sxo/traceSettings.conf`
2. Change the line `LogEx.Enabled=true` to `LogEx.Enabled=false` and save the file.
3. Restart the Oracle OLAP Data Provider.
4. Restart the MDAS.
5 Security

5.1 Configuring the MDAS for Secure Sockets Layer (SSL)

The MDAS communicates with other BI platform servers and web servers using a communication mechanism called CORBA (Common Object Request Broker Architecture). CORBA can be configured to use SSL, a security protocol used to create an encrypted connection for sending sensitive data over CORBA.

For more information about configuring SSL for BI platform servers and services, including the MDAS, see the “Configuring servers for SSL” section of the SAP BusinessObjects Business Intelligence Platform Administrator Guide.
6 Rights Management

6.1 Overview of rights and access levels

Users need certain rights to perform their tasks in Analysis. For example, if a user wants to modify a workspace, then the Edit right must be granted to that user. If a user must save workspaces to certain folders locally or across a network, then that user must be granted sufficient permissions to the folder the workspace is to be saved to.

To create new workspaces, users must be granted the “Create Analysis Workspace” right for the Analysis application, in the Central Management Console (CMC). If users are not granted this right, they are still able to view and edit existing workspaces if they are granted the View and Edit rights. However, they cannot connect to new data sources in existing workspaces.

In addition to being able to grant or deny specific rights, you can assign access levels to users or groups. Access levels allow you to set common security levels quickly and uniformly rather than requiring that individual rights be set individually.

You can use the Central Management Console to add users and groups, and to set rights and access levels for various components of the product suite, including Analysis workspaces and connections.

6.2 Create Analysis Workspace right

Users must be granted the “Create Analysis Workspace” right before they can create new workspaces.

The “Create Analysis Workspace” right also controls a user’s ability to add data source connections to an existing workspace. If a user does not have this right, the Connect to a data source button is not available for any workspace.

6.2.1 To grant the right to create an Analysis workspace

1. Start the Central Management Console (CMC).
   For example, on Windows Server 2008, click Start ➔ All Programs ➔ SAP Business Intelligence ➔ SAP BusinessObjects BI platform 4 ➔ SAP BusinessObjects BI platform Central Management Console.
2. Log on to the CMC.
3. In the Manage area in the CMC, select Applications.
5. Select a user or group and click Assign Security.
6. On the Advanced tab, click Add/Remove Rights.
7. Expand Application, and click Analysis edition for OLAP.
8. Under Specific rights for Analysis edition for OLAP, grant the “Create Analysis Workspace” right.

### 6.3 Rights for Analysis objects

Analysis workspace and data source objects support the General object rights in the Central Management Console; however, not all of the General rights are relevant to Analysis objects. For example, scheduling rights are irrelevant to Analysis objects because Analysis objects are not scheduled in the BI platform.

**OLAP Connections folder rights**

- The View right controls whether a user can see the data source in the Central Management Console, or in the list of available data sources when creating a new Analysis workspace.
- The Edit right controls whether a user can edit the data source object in the CMC.
- Denying the View right to the OLAP Connections folder for a specific user means that the user cannot view or use any OLAP connections in Analysis.
- Denying the View right to a specific OLAP data source object means that a user cannot view an Analysis workspace based on that data source.

**Create Analysis Workspace right**

For users to be able to create workspaces and connect to new data sources in existing workspaces, they must be granted this right in the Central Management Console.

**View right on workspace**

If the View right is denied for a specific workspace, then a user cannot open that workspace. In addition, if the OLAP data source used in the workspace is denied to that user, the workspace will not load.

**Rights for sending workspaces to Inboxes**

If users want to send Analysis workspaces to other BI platform users’ Inboxes, they need to be granted the “View” and “Add objects to the folder” rights to those Inboxes.
Rights for editing, deleting, and sharing custom groups

Users need to have rights for an OLAP connection to edit, delete, or share custom groups based on that connection. For more information, see Setting rights for custom groups [page 53].

Export to Analysis Application right

For users to be able to export a workspace as an analysis application, they must be granted this right in the Central Management Console. A separate Design Studio Runtime right specifies whether users can view analysis applications.

Access levels

In addition to assigning rights, you can use one of the predefined access levels to grant sets of rights to users, or you can define access levels appropriate to your organization’s users. For more information about access levels, see Access levels for Analysis objects [page 50]. If you prefer to grant and deny rights individually, select the Advanced access level.

Note

For more information about how to use the Central Management Console to set access levels and rights for various components of the product suite, including Analysis objects, see the section “Setting Rights” in the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

6.3.1 To set the rights for an Analysis object

1. Start the Central Management Console.
   For example, on Windows, click Start All Programs SAP Business Intelligence SAP BusinessObjects BI platform 4 SAP BusinessObjects BI platform Central Management Console.
2. If you are prompted, enter your user name and password.
3. Click the type of object you want to assign rights for (for example, Folders or Servers).
4. From the list of objects that appears, click the single object you want to assign rights for.
5. Click Manage user security.
6. If you want to add a user or group to the list of users who have rights to the object, click Add Principals.
7. Select the user or group whose rights you want to set, and click Assign Security.
8. Click the Advanced tab.
9. Click Add/Remove Rights.
10. Select the rights, and then click Apply or OK to save the changes.
6.4 Access levels for Analysis objects

Access levels grant sets of object rights. Most users’ access requirements can be met by the proper choice of access level.

**Example**

For example, the View access level grants users a set of rights appropriate for viewing and editing Analysis workspaces, and saving them to folders that they have Edit rights to (their Favorites folder for example), but not for saving them to the original folder. The View access level therefore prevents original workspaces from being overwritten.

Or, if you want to grant users the rights to view workspaces and also save changes back to the original files, you can assign the Full Control access level instead of explicitly granting both the "View objects” and “Edit objects” rights.

**Remember**

Users can add data source connections to the workspace only if they have the Create Analysis Workspace right as well as the appropriate data source and workspace rights.

Analysis objects support the standard access levels in the Central Management Console; however, not all access levels are relevant to Analysis objects:

- **No Access**: Users cannot access the object.
- **View**: Users can view the object, modify it, and save it to a folder that they have Edit rights to, but not save it to the original folder.
- **Schedule**: This access level has no effect on Analysis objects, because Analysis objects are not scheduled in the BI platform.
- **View On Demand**: Similar to the View access level. For some SAP BusinessObjects applications, the set of rights provided by the View On Demand access level differs from the set of rights provided by the View access level, but for Analysis, the View and View On Demand access levels are equivalent.

**Note**

Objects from other SAP BusinessObjects applications, such as Crystal Reports, can be "refreshed" or "viewed on demand" against an updated data source. Analysis objects do not need to be refreshed because the data displayed in Analysis is always the latest data.

- **Full Control**: Users have full administrative control of the object.
You may not want to grant the Full Control access level to many users, because users may unintentionally overwrite the original versions of workspaces saved by analysts. Instead, use the View access level.

6.4.1 To set the access level for an Analysis object

1. Start the Central Management Console.
   For example, on Windows, click Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console.
2. If you are prompted, enter your user name and password.
3. Click the type of object you want to set access levels for (for example, Folders or Servers).
4. From the list of objects that appears, click the single object you want to set access levels for.
5. Click Manage user security.
6. If you want to add a user or group to the list of users who have rights to the object, click Add Principals.
7. Select the user or group whose access level you want to set, and click Assign Security.
8. In the Available Access Levels list, select an access level for that user or group and move it to the Assigned Access Levels list.
   If you want to set advanced (detailed) access rights for a user, click the Advanced tab.
9. Click Apply or OK to save the changes.

For more information about how to use the Central Management Console to set access levels and rights for various components of the product suite, including Analysis objects, see the section “Setting Rights” in the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

6.5 Data access

Analysis offers the flexibility to control which users are able to view or create workspaces, and also which data they can view. This control is in addition to any inherent data security provided by the OLAP server. To enable access to data, you must grant users appropriate rights to the OLAP Connections folder and subfolders, or to specific data source objects.

By default, the access level for the “Everyone” group is set to “No Access” for the OLAP Connections folder. This setting results in these effects for Analysis end users (non-administrators):

- New Analysis workspaces cannot be created.
- End users cannot use any Analysis data sources; therefore, any existing Analysis workspaces will fail to open.
- The OLAP Connections page in the Central Management Console is unavailable.
If you want to allow end users access to specific Analysis data sources, grant those users the “View” access level for those data sources only.

Because rights assigned to a child object override inherited rights, end users can access Analysis data sources if they have been granted the “View” access level for individual data sources, even if their access to the folder containing that data source is set to “No Access”.

If you grant the “View” access level for the OLAP Connections folder to end users, they inherit the “View” access level for the Analysis data source objects inside the folder. If you do not want to allow end users access to a specific data source, you can assign the “No Access” access level to that data source object.

These combinations allow you to control who can and cannot create new Analysis workspaces and Analysis data source objects, plus also control who can view which Analysis-related data.

### Note

Folder management and security on OLAP connections can be managed from both the OLAP Connections page and the Connections page in the CMC. Thus, security assigned on a particular folder impacts all children of that folder even if the connections are to relational data and not OLAP data. For example, restricting rights at the root level implies that the restriction encompasses all subfolders and connections within the root folder; not just OLAP connections.

For more information about how to use the Central Management Console to set access levels for various components of the product suite, including Analysis elements such as workspaces and data source objects, see the section “Setting Rights” in the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

### 6.5.1 To set access rights to the OLAP Connections folder

1. Start the Central Management Console.
   
   For example, on Windows, click **Start** ➤ **All Programs** ➤ **SAP Business Intelligence** ➤ **SAP BusinessObjects BI platform 4** ➤ **SAP BusinessObjects BI platform Central Management Console**.
2. Log on to the Central Management Console.
3. In the **Organize** area in the CMC, select **OLAP Connections**.
4. Click **Manage** ➤ **Top-Level Security** ➤ **All Connections**.
5. Select a user or group in the list, and then click **Assign Security**.
6. Assign the appropriate access levels, or click the **Advanced** tab to assign specific rights. (Access levels are groups of rights.)
   
   Users need at least "View" rights to the OLAP Connections folder to create an Analysis workspace.
7. Click **Apply** or **OK** to save your changes.

### Related Information

Overview of rights and access levels [page 47]
6.6 Changing access to Analysis workspaces

After publishing a workspace, you can use the CMC to change its access permissions.

6.6.1 To change access to workspaces

1. Start the Central Management Console.
   For example, on Windows, click Start ➔ All Programs ➔ SAP Business Intelligence ➔ SAP BusinessObjects BI platform 4 ➔ SAP BusinessObjects BI platform Central Management Console.
2. Log on to the Central Management Console.
3. In the Organize area in the CMC, select Folders or Personal Folders.
4. Expand the folder list as needed to locate the workspace whose properties you want to edit.
5. Select the workspace, and click Manage User Security.
6. Click the User or Group name for which you want to change the access, and then click Assign Security.
7. Assign the appropriate access levels or rights, and then click OK.

**Note**
If either of the inheritance check boxes is selected, the assigned access levels or rights may be superseded by the inherited access. For more information about assigning rights and access levels, see the section “Setting Rights” in the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

6.7 Setting rights for custom groups

Analysis supports custom groups for MSAS and Essbase data sources. You assign rights to edit, delete, and share custom groups at the OLAP connection level.

For example, you can limit which users and groups can edit and delete public custom groups to prevent unintentional changes to your BI content. You may also want to restrict the users and groups who can share custom groups with members of your organization, to reduce the number of unnecessary objects in Analysis and simplify the navigation of BI content. You can set rights for folders of OLAP connections and for individual OLAP connections.

6.7.1 To set rights for editing or deleting custom groups

1. Start the Central Management Console.
   For example, on Windows, click Start ➔ All Programs ➔ SAP Business Intelligence ➔ SAP BusinessObjects BI platform 4 ➔ SAP BusinessObjects BI platform Central Management Console.
2. If you are prompted, enter your user name and password.

3. In the Organize area in the CMC, select OLAP Connections.

4. Choose one of the following:
   - To set rights for all OLAP connections, click Manage User Security.
   - To set rights for a folder of OLAP connections, right-click the folder and click User Security.

5. Select a user or group in the list. Click Assign Security.

6. Click Advanced.

7. Click Add/Remove Rights.

8. Click Application OLP.CustomGroup.

9. To assign a specific right, click Override General Global and select Granted or Denied beside the appropriate right:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete objects that the user owns</td>
<td>This right allows users to delete the private and shared custom groups that they created.</td>
</tr>
<tr>
<td>Delete objects</td>
<td>This right allows users to delete any private or shared custom group that the user has access to.</td>
</tr>
<tr>
<td>Edit objects that the user owns</td>
<td>This right allows users to edit the private and shared custom groups that they created.</td>
</tr>
<tr>
<td>Edit objects</td>
<td>This right allows users to edit any private or shared custom group that the user has access to.</td>
</tr>
</tbody>
</table>

For more information about how to use the Central Management Console to set access levels for various components of the product suite, including Analysis elements such as workspaces and data source objects, see the section “Setting Rights” in the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

6.7.2 To set rights for sharing custom groups

1. Start the Central Management Console.
   - For example, on Windows, click Start All Programs SAP Business Intelligence SAP BusinessObjects BI platform 4 SAP BusinessObjects BI platform Central Management Console.

2. If you are prompted, enter your user name and password.

3. In the Organize area in the CMC, select OLAP Connections.

4. Choose one of the following:
   - To set rights for all OLAP connections, click Manage User Security.
   - To set rights for a folder of OLAP connections, right-click the folder and click User Security.
   - To set rights for a specific OLAP connection, right-click the OLAP connection and click User Security.

5. Select a user or group in the list. Click Assign Security.

6. Click Advanced.
7. Click *Add/Remove Rights*.

8. Click *System ➔ OLAP Connection*.

9. To assign the *Share Custom Group* right, select *Granted* or *Denied* beside the right.

The *Share Custom Group (owner right)* option has no effect on permissions for sharing custom groups.

For more information about how to use the Central Management Console to set access levels for various components of the product suite, including Analysis elements such as workspaces and data source objects, see the section “Setting Rights” in the *SAP BusinessObjects Business Intelligence Platform Administrator Guide*.

### 6.8 Export to Analysis Application right

Users must have the “Export to Analysis Application” right to export an Analysis, edition for OLAP workspace as an analysis application.

**Note**

A separate right specifies whether users are able to view analysis applications. This Design Studio Runtime right is called AAD.Plugin. For more information on configuring this right, see the Administrator Guide: SAP BusinessObjects Design Studio available on the SAP Help Portal at [http://help.sap.com](http://help.sap.com).

### 6.8.1 To grant the right to export a workspace as an analysis application

1. Start the Central Management Console (CMC).
   
   For example, on Windows Server 2008, click *Start ➔ All Programs ➔ SAP Business Intelligence ➔ SAP BusinessObjects BI platform 4 ➔ SAP BusinessObjects BI platform Central Management Console*.

2. Log on to the CMC.

3. In the Manage area in the CMC, select *Applications*.

4. Right-click *Analysis edition for OLAP* and select *User Security*.
   
   The *User Security* dialog box appears.

5. Select a user or group and click *Assign Security*.

6. On the *Advanced* tab, click *Add/Remove Rights*.

7. Expand *Application*, and click *Analysis edition for OLAP*.

8. Under *Specific rights for Analysis edition for OLAP*, grant the “Export to Analysis Application” right.
7 MDAS Maintenance

7.1 Starting and stopping the Server Intelligence Agent

The Server Intelligence Agent (SIA) manages all BI platform servers and services, including the MDAS. When you start the BI platform, the SIA is started automatically, as are any BI platform servers that are configured to start when the SIA starts.

Also, the SIA properties, for example the Logon As account or the Startup Type, are propagated to all of the servers that run under the SIA.

On Windows, you use the Central Configuration Manager (CCM) to start and stop the SIA. On all supported UNIX platforms, you run the scripts `startservers.sh` and `stopservers.sh` from a command prompt to start and stop the SIA.

For more information about the Server Intelligence Agent, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

7.2 Starting and stopping the Multi-Dimensional Analysis Service

There may be occasions when you need to stop or start the MDAS manually.

For example, if you have configured a cluster of MDAS instances, you may want to start or stop the individual instances depending on load conditions.

For more information about starting and stopping BI platform servers and services, including the MDAS, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

7.3 Restarting the Multi-Dimensional Analysis Service

There may be occasions when you need to restart the MDAS.

For example:

- The configuration files have changed and need to be reloaded.
- An administrator changes the port and interface name, and a restart is required before the changes take effect.
- The MDAS has encountered an error condition that it cannot recover from.

For more information about restarting BI platform servers and services, including the MDAS, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.
7.4  Enabling and disabling an MDAS instance

When you disable a BI platform server, you prevent it from receiving and responding to new requests, but you do not actually stop the server process. This is especially useful when you want to allow a server to finish processing all of its current requests before you stop it completely.

When you disable an MDAS instance, the service still continues running as a service, but will not accept any new requests from Analysis or the Central Management Console (CMC).

When you enable a running MDAS instance, the MDAS instance accepts new requests from Analysis or the CMC; for example, creating a connection.

For more information about enabling and disabling BI platform servers and services, including the MDAS, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

7.5  Adding and removing MDAS instances

You can create more than one running MDAS instance. You can either create a new MDAS by specifying its parameters, or you can create a new MDAS based on an existing MDAS. Once you have added a new MDAS instance, you must start and enable it.

For more information about adding and removing BI platform servers and services, including the MDAS, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

Related Information

Cloning Analysis server deployments [page 21]
Starting and stopping the Multi-Dimensional Analysis Service [page 56]
Restarting the Multi-Dimensional Analysis Service [page 56]
Enabling and disabling an MDAS instance [page 57]

7.6  Configuration files for the MDAS Server

You can edit the mdas.properties and mdaclient.properties configuration files to customize your Analysis deployment.

The mdas.properties configuration file can be found at these locations:

- On Windows:
  C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\java\pjs\services\MDAS\resources\com\businessobjects\multidimensional\services
On UNIX:
<BI platform install directory>/sap_bobj/enterprise_xi40/java/pjs/services/MDAS/resources/com/businessobjects/multidimensional/services/

The \texttt{mdaclient.properties} configuration file can be found at these locations:

- On Windows:
  C:\Program Files (x86)\SAP BusinessObjects\tomcat\webapps\BOE\WEB-INF\config\default

- On UNIX:
  <BI platform install directory>/tomcat/webapps/BOE/WEB-INF/config/default

### 7.6.1 MDAS configuration file—\texttt{mdas.properties}

You can configure the behavior of an individual MDAS instance by modifying parameters in its associated \texttt{mdas.properties} file. Parameters include the server timeout, the maximum number of cells to export to Excel, as well as various parameters used for development and testing purposes that should not be changed or referenced in a production environment.

It is recommended that you do not edit the \texttt{mdas.properties} file unless you fully understand the effect each parameter has on MDAS operation.

Any changes made to this configuration file will not take effect until the next time the MDAS is restarted.

#### 7.6.1.1 \texttt{mdas.properties} file listing

```ini
# Turn this value to false in deployed environments to ensure the
# server is not using xml validation. This value should be true in
# development environments.
multidimensional.services.server.xml.use_validation=false

# Flag indicating whether or not xml data returned by
# MDAS should be pretty printed. This helps debugging
# but slows performance
multidimensional.services.server.xml.prettyprint=false

# none, info, verbose.
multidimensional.services.transport.trace.level=none

# The number of milliseconds before idle session is closed by the session
# monitor.
# Default time is set to 30 minutes
multidimensional.services.server.session.monitor.idle.timeout=1800000

# The upper bound on the number of cells that may be exported to csv,
# excel, etc. As exporting large data sets requires large amounts of
# memory the size of the export is limited. Increasing this
# threshold may cause the server to run out of memory. Please
# coordinate changes to this value with your memory settings and
# expected user load.
multidimensional.services.export.cells.limit=100000

# For logging BICS profile data purpose, set it to true.
multidimensional.services.bics.profiling.enabled=false

# Flag indicating whether auto drilling is enabled for
# data providers that have asymmetric drilling
multidimensional.services.asymmetric.autodrilling.enabled=true

# Flag indicating whether metadata items (i.e. characteristic
# and hierarchies) will be sorted alphabetically
```
7.6.2 MDAS client configuration file—mdaclient.properties

The mdaclient.properties file contains the following parameters:

- The number of rows returned before making another server request.
- The number of columns returned before making another server request.
- The visibility of row, column, and cell count information.
- The setting for selecting whether the JumpLink dialog box always uses member keys, or uses the "Display as" setting from the Layout panel.
- The maximum number of hierarchies that can be added to a custom group.
Changing the default tab in open source dialog box

In the Open Data Source dialog box, you can change the behavior of the tab view. The Find tab is the default tab. To change the default tab, perform the following steps:

1. Stop the Application server (Example: Tomcat)
2. Navigate to `<BOE INSTALL DIRECTORY>\SAP BusinessObjects\tomcat\webapps\BOE\WEB-INF\config\custom`
3. Open the `mdaclient.properties` file
4. Modify the below property:

```
opendatasource.systemconnection.default.isFindTab=true
```

For changing the behavior to folder tab, set `opendatasource.systemconnection.default.isFindTab = false`.
5. Save the changes.
6. Start Application server (Example: Tomcat)

Finding follows these rules:

- In SAP BW and SAP HANA systems, the find is performed on both the name and description of data source objects. In other systems, the find is performed only on cube names.
- To find only those data sources whose text or key exactly matches your search string, enclose your search string in quotation marks.
- To find data sources whose text or key includes your search string, do not enclose your search string in quotation marks.
- If your search string comprises multiple words separated by spaces, a separate find is executed for each word, and the results are aggregated.
- You can use an asterisk (*) as a wildcard character. To include an asterisk as a regular character within the search string, enclose the search string in quotation marks.
- If exactly one matching data source is found, and either the text or key exactly matches the search string, then the data source is automatically selected.

7.6.2.1 mdaclient.properties parameters

```
#Configure the number of rows the Crosstab will request before making another request to the server.
#Zero based value means that to fetch say 60 rows, the value should be set to 59.
crosstab.rowsize=199

#Configure the number of columns the Crosstab will request before making another request to the server.
#Zero based value means that to fetch say 40 columns, the value should be set to 39.
crosstab.columnsize=23

#Configure the visibility of the Row, Column and Cell count information at the top of the Crosstab.
#true is on and false is off

crosstab.showcountinfo=true

#Configure whether the JumpLinks dialog will use member keys, rather than the member display strings shown in the UI.
crosstab.useMemberKeys=true
```
In the CMC, you can access MDAS metrics, and configure MDAS properties. To access the metrics and properties, perform these steps:

1. In the Organize area in the CMC, select Servers.
2. Select Service Categories ➔ Analysis Services ➔

You can now configure the MDAS properties, or access the Metrics page from the navigation pane.

### 7.7 Properties page

The Properties page contains settings for the Adaptive Processing Server and its running services, including the MDAS.

For more information about server properties, see the “Server Properties Appendix” in the SAP BusinessObjects Business Intelligence Platform Administrator Guide.
Multi Dimensional Analysis Service properties

- **Maximum Client Sessions**: This setting defines the maximum number of sessions that can simultaneously be open on a given MDAS. When the number of open sessions reaches this number, any additional attempts to start Analysis sessions result in a “server unavailable” error message. You can change this value to optimize MDAS performance, depending on your needs and available hardware, but increasing the value may result in performance issues for both the MDAS and the database server.

- **Maximum number of cells returned by a query**: This setting allows an administrator to control the maximum number of cells returned to the user in a single query. The user is prevented from executing a query that returns an extremely large number of cells, consuming a large amount of memory. If the user’s query exceeds this cell limit, the user receives an error message.

- **Maximum number of members returned when filtering**: This setting allows an administrator to control the number of members retrieved when filtering by member. A very large number of retrieved members can consume a large amount of memory.

These are some situations that can cause a large number of members to be retrieved:

- Open the “Filter by member” panel with a large flat list.
- Open the “Filter by member” panel with a large hierarchy, and with the tree fully expanded.
- Expand a parent member that has many children.
- View the leaf members level.
- Find members using the asterisk wildcard character “*”.

7.7.2 Metrics page

The Metrics page displays information about the Adaptive Processing Server and its running services, including the MDAS.

For more information about server metrics, see the “Server Metrics Appendix” in the *SAP BusinessObjects Business Intelligence Platform Administrator Guide*.

Multi Dimensional Analysis Service metrics

- **Session Count**: This setting indicates the current number of connections from the Analysis client(s) to the MDAS. Note that if a client has several workspaces open, each workspace represents a connection that has not timed out.

- **Query Count**: The number of data requests that are open between the Analysis client and the database server(s). Note that an active query may be between any of the active sessions and any of the active data sources.

- **Cube Count**: This setting indicates the number of data sources that are being used to supply data to the connections (as indicated above by the number of active sessions) that have not timed out.
8 Data Source Connections

8.1 Creating OLAP data source connections

Before users can begin working with business data in Analysis, edition for OLAP, you must create connections to OLAP data sources for them to add to their Analysis workspaces.

An OLAP data source connection is a BI platform repository object that contains all the information that is required for Analysis to connect to an OLAP data source. This connection object is then linked to an Analysis workspace.

You can create connections to individual OLAP cubes or SAP BW queries, or to data source systems containing many cubes and queries. If a user adds a data source system connection to a workspace, the user must then choose an individual cube or query from the system.

You create new Analysis data source connection objects and manage existing connection objects in the Central Management Console (CMC). Connections can be saved to a single folder, or you can create subfolders to help you group your connection objects together and administer access rights. For example, you could create a folder for SAP BW data source connections, and another folder for Microsoft Analysis Services data source connections, and grant users access to only one of the folders.

Once you have created data source connections, these data sources appear in the list of data sources in the Open Data Source dialog box in the Analysis web client, and are available for your users to add to their workspaces.

i Note
In the Analysis client application, all data sources are shown in a flat list even if you organize them by folders in the CMC.

i Note
OLAP connections are shared with other applications, such as SAP Crystal Reports, SAP BusinessObjects Web Intelligence, and the Information Design Tool.

Related Information

IIS configuration for MSAS connectivity [page 95]
Managing Analysis data source connections [page 81]
8.1.1 To create a new connection object for a data source system

1. Start the Central Management Console.
   For example, on Windows, click Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console.

2. Log on to the Central Management Console.

3. In the Organize area in the CMC, select OLAP Connections.

4. Select the folder where you want your new connection to be placed.
   You can select the Connections folder or any subfolder, or create a new subfolder.

5. Click New Connection.

6. Type a Name and optionally type a Description for your connection.

7. Select an OLAP provider from the list.

8. Enter the provider-specific server information, such as the server name.

9. Select an authentication type.

10. Click Save to create the connection.
   The connection is now available for users to add to a workspace.

Related Information

Data source connection settings [page 71]
Finding a cube or query [page 65]
Creating OLAP data source connections [page 63]

8.1.2 To create a new connection object for a cube or a query

1. Start the Central Management Console.
   For example, on Windows, click Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console.

2. Log on to the Central Management Console.

3. In the Organize area in the CMC, select OLAP Connections.

4. Select the folder where you want your new connection to be placed.
   You can select the Connections folder or any subfolder, or create a new subfolder.

5. Click New Connection.

6. Type a Name and optionally type a Description for your connection.
7. Select an OLAP provider from the list.
8. Enter the provider-specific server information, such as the server name.
9. Click Connect.
10. If necessary, enter your credentials and click OK.
11. In the Cube Browser, select the cube or query that you want to use for this connection, and then click Select. You can manually browse through the folders in the Cube Browser to locate your cube or query, or you can search for it.
12. Select an authentication type.
13. Click Save to create the connection.
   The connection is now available for users to add to a workspace.

Related Information

Data source connection settings [page 71]
Finding a cube or query [page 65]
Creating OLAP data source connections [page 63]

8.1.3 Finding a cube or query

The Cube Browser provides search capabilities to help you locate a cube or SAP BW query within a data source system.

Searching in the Cube Browser

You can type a search string in the text field at the top of the Cube Browser to find a cube or SAP BW query.

Note

For SAP BW data sources, you can view data sources by Caption or Name. This choice does not affect the search itself. If you receive search results that do not appear to relate to your search terms, toggle between Name and Caption to see the relevant results for your search terms.

If no cubes or queries match the search string, “No cubes found.” is displayed.

Use the Return to Cube List button to clear the search results and return to the full data source list.

Analysis uses the same search techniques as popular internet search engines:
Table 2:

<table>
<thead>
<tr>
<th>Search String</th>
<th>Search Result</th>
</tr>
</thead>
</table>
| `sales`        | Finds all cubes and queries whose names contain the word `sales`, such as `sales reports` and `store sales`.
|                | **Note**     |
|                | If you search for `sales`, your search will not find a cube named `sales2008`. To find `sales2008`, you could search for `sales*`. See the section Using wildcards in your search. |
| "sales reports"| Finds only cubes and queries whose names contain the exact text inside the quotation marks. In this example, the search would find `sales reports` but not `sales and purchase reports`. |
| `sales reports`| Multiple terms include an implicit AND, so in this example, the search would find all cubes and queries whose names contain both the words `sales` and `reports`:
  * `sales reports`
  * `sales and purchase reports` |
| `sales OR reports`| Finds cubes and queries whose names contain either the word `sales` or the word `reports`. The OR must be capitalized. In this example, the search would find cubes and queries with these names:
  * `sales reports`
  * `purchase reports`
  * `reports`
  * `store sales` |

| **Note** |
| Search terms are not case-sensitive. Searching for `sales` is the same as searching for `Sales` or `SALES` or `saLEs`. |

### Using wildcards in your search

You can use wildcard characters in your search string.

Table 3:

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Represents</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>*</code></td>
<td>Represents a string of zero or more characters. For example, a search for <code>sales*</code> finds both <code>sales</code> and <code>sales2008</code>.</td>
</tr>
</tbody>
</table>
8.1.4 To copy a connection object

1. Start the Central Management Console.
   For example, on Windows, click Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console.
2. Log on to the Central Management Console.
3. In the Organize area in the CMC, select OLAP Connections.
4. Select the connection that you want to copy.
5. Click Copy Connection.
6. Type a Name and optionally type a Description for your connection.
   You can choose to save the copied connection now, or make changes to the connection settings.
7. Click Save to create the connection.
   The connection is now available for users to add to a workspace.

Related Information

Data source connection settings [page 71]

8.1.5 Authentication

You can set the type of authentication to use when users create new workspaces or log on to existing workspaces.

You can choose from the following authentication types when you create an Analysis connection in the CMC:

Prompt

When this type is selected for the connection, the end user will be prompted with a dialog box to enter a username and password when Analysis initiates the connection.

Note

The username and password are not encrypted by Analysis. To protect usernames and passwords, you must enable SSL on your web application server.
Pre-defined

With this option selected, the administrator enters a specific username and password which will be stored as part of the connection object. The stored username and password will always be used to authenticate to the back-end server when this connection object is accessed from Analysis. Like single sign-on, this authentication type does not require the end user to enter a username and password in Analysis. However, because the same credentials are used for every user who accesses the cube through this connection, this option is not always suitable.

SSO (single sign-on)

With the single sign-on option selected, the user signs on once to the BI launch pad, and then is able to connect to the back-end servers in Analysis without having to enter the username and password again. Analysis (through the MDAS) automatically retrieves the credentials from the current BI launch pad session and passes them to the server.

These OLAP providers support single sign-on:

Table 4:

<table>
<thead>
<tr>
<th>Provider</th>
<th>Authentication</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP BW</td>
<td>SAP authentication including Secure Network Communications</td>
</tr>
<tr>
<td>Microsoft Analysis Services</td>
<td>Windows Active Directory</td>
</tr>
<tr>
<td>SAP BusinessObjects Planning and Consolidation</td>
<td>Enterprise</td>
</tr>
<tr>
<td>SAP BusinessObjects Extended Analytics (v10 only)</td>
<td>Windows Active Directory, LDAP, or Enterprise</td>
</tr>
<tr>
<td>SAP BusinessObjects Profitability and Cost Management</td>
<td>Enterprise</td>
</tr>
<tr>
<td>SAP HANA</td>
<td>Enterprise</td>
</tr>
</tbody>
</table>

For Microsoft Analysis Services, single sign-on works only if the following conditions are true:

1. SAP BusinessObjects Business Intelligence platform is configured correctly for Active Directory authentication in a Java environment. See the SAP BusinessObjects Business Intelligence Platform Administrator Guide and the technical brief Configuring Active Directory Authentication using Java Application Servers for more information.
2. All CMS and MDAS instances must be started with the identical domain account. This service account must be trusted for delegation in Active Directory.
3. The user signs on to the BI launch pad using the Active Directory authentication plug-in.

For SAP HANA, single sign-on is implemented using SAML (Security Assertion Markup Language). SAML must be configured in both the BI platform and SAP HANA. User mapping between BI platform users and SAP HANA users must also be configured in SAP HANA.

For information about configuring single-sign on with SAP HANA, refer to the “Configuring SAP HANA single sign-on” section of the SAP BusinessObjects Business Intelligence Platform Administrator Guide. For information about configuring SAP HANA SAML settings, refer to the “Authentication Using SAML Bearer Token” section of the SAP HANA Security Guide. These guides are available on the SAP Help Portal at http://help.sap.com.
8.2 To change connection settings

1. Start the Central Management Console.
   For example, on Windows, click Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console.
2. Log on to the Central Management Console.
3. In the Organize area in the CMC, select OLAP Connections.
   A list of existing connections is displayed.
   
   **Note**
   If no connections are listed, you need to create a new OLAP connection to allow your data analysts to begin working with Analysis workspaces.
4. Select the connection that you want to edit, and click Edit Connection.
   
   **Note**
   If you do not have “Add objects to the folder” permission in the BI platform system, you cannot edit a connection, and the Edit Connection button is unavailable.

You can now change the contents of any of the fields to reconfigure your OLAP connection.
5. Click Save to save the new connection settings.

**Related Information**

To change connection settings [page 69]
Data source connection settings [page 71]

8.2.1 To change connection settings

1. Start the Central Management Console.
   For example, on Windows, click Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console.
2. Log on to the Central Management Console.
3. In the Organize area in the CMC, select OLAP Connections.
   A list of existing connections is displayed.
4. Select the connection that you want to edit, and click **Edit Connection**.

**Note**

If you do not have "Add objects to the folder" permission in the BI platform system, you cannot edit a connection, and the Edit Connection button is unavailable.

You can now change the contents of any of the fields to reconfigure your OLAP connection.

5. Click **Save** to save the new connection settings.

**Related Information**

- To change connection settings [page 69]
- Data source connection settings [page 71]

### 8.3 Deleting a connection

If a data source connection is no longer being used, you can delete the connection.

**Note**

If you delete a connection that is still being used by any workspaces, those workspaces are rendered inoperable. Therefore, you should verify in the Central Management Console that no workspaces use a connection before you delete that connection.

**Related Information**

- Displaying a list of workspaces that use a data source connection [page 82]

#### 8.3.1 To delete a connection

1. Start the Central Management Console.
For example, on Windows, click Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console.

2. Log on to the Central Management Console.

3. In the Organize area in the CMC, select OLAP Connections.
   A list of existing connections is displayed.

4. Select the connection that you want to delete.

5. From the menu, select Manage > Delete.

### 8.4 Moving a connection to another folder

You can move data source connections between folders in the CMC.

#### 8.4.1 To move a connection object

1. Start the Central Management Console.
   For example, on Windows, click Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console.

2. Log on to the Central Management Console.

3. In the Organize area in the CMC, select OLAP Connections.

4. Select the connection that you want to move.

5. Click Organize > Move To.

6. Select a destination folder, and then click Move.

### 8.5 Data source connection settings

This section describes the provider-specific connection settings for all supported OLAP data sources:

- Connection settings for SAP Business Warehouse data sources [page 72]
- Connection settings for Microsoft Analysis Services data sources [page 73]
- Connection settings for Oracle Essbase data sources [page 79]
- Connection settings for SAP BusinessObjects Profitability and Cost Management data sources [page 74]
- Connection settings for SAP BusinessObjects Extended Analytics data sources [page 74]
- Connection settings for SAP BusinessObjects Planning and Consolidation data sources [page 75]
- Connection settings for SAP HANA data sources [page 76]
- Connection settings for Teradata data sources [page 79]
• Connection settings for Oracle OLAP data sources [page 80]

For more information, refer to the documentation for those products.

8.5.1 Connection settings for SAP Business Warehouse data sources

Connecting to an application server

To connect directly to an SAP BW application server, choose Server for Server Type. The following information is required to establish a connection to an application server:

• System: The three-character SAP system ID
• Server: Name or IP address of the application server
• System Number
• Client: The three digit client number

Connecting to a logon group

You can leverage SAP load balancing by connecting to a logon group. To connect to a logon group, choose Group for Server Type. The following information is required to establish a connection to a logon group:

• System: The three character SAP system ID
• Group Name: Name of the logon group
• Message Server: Name or IP address of the message server
• Client: The three digit client number

Setting a language

The language field accepts a two character ISO language code. For example, enter EN for English, DE for German, or FR for French. The language code you enter here will be used when connecting to the server in order to choose a data source.

You can also choose whether or not to save the language code as part of the data source connection object. If you choose to save the language, then all Analysis workspaces that reference that data source will log in with the specified language.

If you choose not to save the language, then Analysis workspaces that reference the data source will log in with the language of the user’s active BI platform session.
## Authentication types

The following authentication types are supported for SAP BW data sources:

- **Prompt**
  Prompt the user for an SAP username and password to authenticate to the data source.

- **SSO**
  When the user opens an Analysis workspace, the application retrieves the SAP logon information from the user’s current BI platform session. The user is not prompted to enter a username or password. For this option to work, SAP BusinessObjects Business Intelligence platform must be configured correctly for SAP authentication. Refer to the “SAP authentication” section in the *SAP BusinessObjects Business Intelligence Platform Administrator Guide* for more details.

- **Pre-defined**
  Connect to the data source with the SAP username and password saved as part of the connection.

### 8.5.2 Connection settings for Microsoft Analysis Services data sources

These connection settings are configurable with Microsoft OLAP data sources such as Microsoft SQL Server 2012 Analysis Services:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server Information</strong></td>
<td>Connect to a cube on an Analysis Services server by providing the URL to the IIS instance that processes XMLA requests for the server. For example: http://&lt;IIS servername&gt;/olap/msmdpump.dll, where &lt;IIS servername&gt; is the name of your IIS server. You can use localhost as the IIS server name if everything is installed on one server.</td>
</tr>
<tr>
<td><strong>Authentication type</strong></td>
<td>Set the type of authentication to use when users create new workspaces or log on to existing workspaces. These options are available:</td>
</tr>
</tbody>
</table>
|                          | ● Prompt  
  Always prompt users for logon credentials.                                                |
|                          | ● SSO (single sign-on)  
  Uses the credentials that users enter when they log on to their BI launch pad sessions. |
|                          | ● Pre-defined  
  Always use the username and password that were specified when the connection was created by the administrator.                              |
| **Language**             | Select a language from the list.                                                                                                             |
|                          | The language that you select will be used when connecting to the server in order to choose a data source. |
### 8.5.3 Connection settings for SAP BusinessObjects Profitability and Cost Management data sources

These connection settings are configurable with Profitability and Cost Management data sources:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server Information</strong></td>
<td>Connect to a cube on a Profitability and Cost Management server by providing the URL to the web server that processes XMLA requests for the server.</td>
</tr>
</tbody>
</table>
| **Authentication type** | Set the type of authentication to use when users create new workspaces or log on to existing workspaces. These options are available:  
  - **Prompt**  
    Always prompt users for logon credentials.  
  - **SSO (single sign-on)**  
    Uses the credentials that users enter when they log on to their BI launch pad sessions.  
  - **Pre-defined**  
    Always use the username and password that were specified when the connection was created by the administrator. |

For more information, see the documentation for Profitability and Cost Management.

### 8.5.4 Connection settings for SAP BusinessObjects Extended Analytics data sources

These connection settings are configurable with Extended Analytics data sources:

Table 7:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Information</td>
<td>Connect to a cube on an Extended Analytics server by providing the URL to the web server that processes XMLA requests for the server.</td>
</tr>
<tr>
<td>Authentication type</td>
<td>Set the type of authentication to use when users create new workspaces or log on to existing workspaces. These options are available:</td>
</tr>
<tr>
<td></td>
<td>• Prompt \nAlways prompt users for logon credentials.</td>
</tr>
<tr>
<td></td>
<td>• SSO (single sign-on) (available with Extended Analytics version 10 only) \nUses the credentials that users enter when they log on to their BI launch pad sessions.</td>
</tr>
<tr>
<td></td>
<td>• Pre-defined \nAlways use the username and password that were specified when the connection was created by the administrator.</td>
</tr>
</tbody>
</table>

For more information, see the documentation for Extended Analytics.

8.5.5 Connection settings for SAP BusinessObjects Planning and Consolidation data sources

These connection settings are configurable with Planning and Consolidation 7.5 and Planning and Consolidation 10, version for the Microsoft Platform data sources:

Table 8:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Information</td>
<td>Connect to a cube on a Planning and Consolidation server by providing the URL to the web server that processes XMLA requests for the server.</td>
</tr>
<tr>
<td>Authentication type</td>
<td>Set the type of authentication to use when users create new workspaces or log on to existing workspaces. These options are available:</td>
</tr>
<tr>
<td></td>
<td>• Prompt \nAlways prompt users for logon credentials.</td>
</tr>
<tr>
<td></td>
<td>• SSO (single sign-on) \nUses the credentials that users enter when they log on to their BI launch pad sessions.</td>
</tr>
<tr>
<td></td>
<td>• Pre-defined \nAlways use the username and password that were specified when the connection was created by the administrator.</td>
</tr>
</tbody>
</table>

Connections to Planning and Consolidation 10, version for SAP technology use the same settings as SAP Business Warehouse connections. See Connection settings for SAP Business Warehouse data sources [page 72] for more information.

For more information, see the documentation for Planning and Consolidation.
8.5.6 Connection settings for SAP HANA data sources

These connection settings are configurable with SAP HANA data sources:

Table 9:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Type the name of the server.</td>
</tr>
<tr>
<td>Instance Number</td>
<td>Type the instance number for the connection.</td>
</tr>
<tr>
<td>Authentication type</td>
<td>Set the type of authentication to use when users create new workspaces or log on to existing workspaces. These options are available:</td>
</tr>
<tr>
<td></td>
<td>● Prompt</td>
</tr>
<tr>
<td></td>
<td>Always prompt users for logon credentials.</td>
</tr>
<tr>
<td></td>
<td>● SSO (single sign-on)</td>
</tr>
<tr>
<td></td>
<td>Authenticate using SAML and user mapping between SAP HANA and the BI platform.</td>
</tr>
<tr>
<td></td>
<td>● Pre-defined</td>
</tr>
<tr>
<td></td>
<td>Always use the username and password that were specified when the connection was created by the administrator.</td>
</tr>
</tbody>
</table>

For more information, see the documentation for SAP HANA available on the SAP Help Portal at http://help.sap.com.

8.5.7 Connection settings for SAP HANA HTTP

These connection settings are configurable with SAP HANA HTTP

Table 10:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Type the URL (http://&lt;host&gt;:&lt;port&gt;)</td>
</tr>
<tr>
<td>Authentication type</td>
<td>Set the type of authentication to use when users create new workspaces or log on to existing workspaces. These options are available:</td>
</tr>
<tr>
<td></td>
<td>● Prompt</td>
</tr>
<tr>
<td></td>
<td>Always prompt users for logon credentials.</td>
</tr>
<tr>
<td></td>
<td>● SSO (single sign-on)</td>
</tr>
<tr>
<td></td>
<td>Authenticate using SAML and user mapping between SAP HANA and the BI platform.</td>
</tr>
<tr>
<td></td>
<td>● Pre-defined</td>
</tr>
<tr>
<td></td>
<td>Always use the username and password that were specified when the connection was created by the administrator.</td>
</tr>
</tbody>
</table>

For more information, see the documentation for SAP HANA available on the SAP Help Portal at http://help.sap.com.
8.5.7.1 Configuration for SAP HANA HTTP

If you use the SAP HANA appliance software, you can analyze SAP HANA data sources with Analysis via HTTP connection. The connection to the SAP HANA platform relies on the http(s) protocol for the communication with the SAP HANA server. You can connect to the SAP HANA platform with HTTP connection via SAP BusinessObjects Business Intelligence platform. This connection can be created directly in the CMC of the SAP BusinessObjects BI platform.

To create an SAP HANA HTTP connection, on the BI platform, the following prerequisites must be met:

- You use SAP HANA Platform SPS09 or a higher version.
- The SAP HANA Info Access Service (InA) with delivery unit HCO_INA_SERVICE is deployed on the HANA platform. You can find more information in chapter Importing the Info Access Service in the SAP HANA Search Developer Guide. The role is contained in delivery unit HCO_INA_SERVICE. Verify that the following authorizations are selected: Schema _SYS_BIC, Schema _SYS_BI and Schema _SYS_RT. For more information, see SAP Note 2097965.
- The role sap.bc.ina.service.v2.userRole::INA_USER is assigned.

8.5.7.2 Creating an SAP HANA HTTP connection on the BI platform

The mdas.properties file contains, MDAS property multidimensional.services.enable.hana.http.connections.

The default parameter for the MDAS property in the mdas.property file is "false". To enable the connection, set the parameter of MDAS property as "True".

The configuration file can be found on Windows under <Install_Dir>\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\java\pjs\services\MDAS\resources\com\businessobjects\multidimensional\services and on Unix under <Install_Dir>/sap_bobj/enterprise_xi40/java/pjs/services/MDAS/resources/com/businessobjects/multidimensional/services.

On the BI platform, you can create an HTTP connection to an SAP HANA Server in the central management console.

To create an SAP HANA HTTP connection on the BI platform, perform the following steps:

1. Log on to the Central Management Console (CMC).
2. Select OLAP Connections.
3. Select New Connection.
4. Enter a name and a description. The description is optional.
5. Select SAP HANA http provider
6. As Server Information enter a URL with the following structure:
   
   We recommend to use HTTPS as scheme
The default HTTP and HTTPS port settings for SAP HANA XS includes the following SAP HANA instance number:

- HTTP: 80< instance number>
- HTTPS: 43< instance number>

For example:

- If 01 is the SAP HANA instance, then the default HTTP port for SAP HANA XS is 8001.
- If 01 is the SAP HANA instance, then the default HTTPS port for SAP HANA XS is 4301.

You can change the default settings, for example, to ensure that standard ports 80 and 43 are used for client access to the SAP HANA XS Web server HTTP (80) or HTTPS (43).

For more information, see chapter Maintain Standard HTTP Port Numbers with SAP HANA XS in the SAP HANA Administration Guide.

7. Select the **Authentication** type.

- **Prompts**
  - When this type is selected for the connection, the end user will be prompted with a dialog box to enter a user ID and password.
- **SSO (Single Sign On)**
  - With the single sign-on option selected, the user has to sign on once. The authentication method for this connection is SAML 2.0.
  - For more information, see chapters User Authentication and Single-Sign On and Maintaining Single Sign-On for SAP HANA XS Applications in the SAP HANA Administration Guide.
- **Pre-Defined**
  - With this option selected, the administrator enters a specific user and password which will be stored as part of the connection object. Like single sign-on, this authentication type does not require the end user to enter a user ID and password.

8. Select **Save** to create the connection.

Associated Universes are ignored for SAP HANA HTTP connections. The new connection is available in the **OLAP Connection** list.

You can also edit and delete existing SAP HANA connections in this dialog.

### 8.5.7.3 Troubleshooting for SAP HANA HTTP connections

#### Verifying the URL for the SAP HANA HTTP connection

1. Complete the test URL with server name and port of your connection:

   http(s)://<server>:<port>/sap/bc/ina/service/v2/GetServerInfo

2. Open a browser and paste the URL.

3. You get one of the following responses:

   - HTTP 404 - not found
     - This indicates that the server is not reachable (e.g. down or behind a firewall) or that the SAP HANA Info Access Service (InA) is not deployed.
○ The dialog to enter user and password is displayed.
- If you have configured an SSO access, this indicates that the log-on was not successful.
○ A response is returned with a JSON Format containing information about the server capabilities.
- This indicates that the log-on was successful.

Verifying Basic Data Base Access Rights (Index Server)

1. Complete the test URL with server name and port of your connection: http(s)://
   <server>:<port>/sap/bc/ina/service/v2/GetResponse?Request={%22Metadata%22:
   {%22Expand%22:[%22Cubes%22]}}
2. Open a browser and paste the URL.
3. Check that you receive a response without error.

8.5.8 Connection settings for Teradata data sources

These connection settings are configurable with Teradata OLAP data sources:

Table 11:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Information</td>
<td>Type a URL to a Teradata server that processes XMLA requests.</td>
</tr>
<tr>
<td>Authentication type</td>
<td>Set the type of authentication to use when users create new workspaces or log on to existing workspaces. These options are available:</td>
</tr>
</tbody>
</table>
|                        | ● Prompt
|                        | Always prompt users for logon credentials.                                  |
|                        | ● Pre-defined
|                        | Always use the username and password that were specified when the connection was created by the administrator. |

For more information, see the documentation for Teradata.

8.5.9 Connection settings for Oracle Essbase data sources

The following connection settings are configurable with Oracle Essbase data sources.

Table 12:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Information</td>
<td>Type the URL for the Essbase server, including the port if necessary. If you do not specify a port, the default port 1423 is used.</td>
</tr>
</tbody>
</table>
Setting | Description
--- | ---
Authentication type | Set the type of authentication to use when users create new workspaces or log on to existing workspaces. These options are available:
- Prompt
  Always prompt users for logon credentials.
- Pre-defined
  Always use the username and password that were specified when the connection was created by the administrator.

Related Information

To configure the BI platform for Essbase OLAP connections [page 20]

8.5.10 Connection settings for Oracle OLAP data sources

The following connection settings are configurable with data sources that connect to the Oracle OLAP Data Provider for SAP BusinessObjects Business Intelligence.

**Note**

You must install and configure the Oracle OLAP Data Provider before creating this type of data source connection.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Information</td>
<td>Connect to a cube on an Oracle OLAP server by providing the URL to the web server that processes XMLA requests for the server, for example, http://&lt;server&gt;:&lt;port&gt;/M40XmlaWebService/services/XmlaWebService/</td>
</tr>
</tbody>
</table>
| Authentication type | Set the type of authentication to use when users create new workspaces or log on to existing workspaces. These options are available:
- Prompt
  Always prompt users for logon credentials.
- Pre-defined
  Always use the username and password that were specified when the connection was created by the administrator. |

For more information, see the documentation for Oracle OLAP.
Related Information

Oracle OLAP Data Provider for SAP BusinessObjects Business Intelligence [page 26]
To enable the Oracle OLAP Data Provider for Analysis [page 42]

8.6 Managing Analysis data source connections

The Central Management Console (CMC) is a web-based administration tool for managing Analysis data source connections and workspaces, user accounts, rights, folders, server settings, and license keys. You must be a BI platform administrator to access the CMC.

See the SAP BusinessObjects Business Intelligence Platform Administrator Guide for information about logging on to the CMC.

In the CMC, you can change the properties of saved Analysis data source connection objects. You can also view a list of workspaces that use the data source.

8.6.1 Editing the title and description of an Analysis data source connection

In the CMC, you can change the title and description properties of saved Analysis data source connection objects.

8.6.1.1 To change the properties of existing data source connection objects

1. Start the Central Management Console.
   For example, on Windows, click Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console.
2. Log on to the Central Management Console.
3. In the Organize area in the CMC, select OLAP Connections.
   A list of all data source connections is displayed.
4. Double-click a connection to open its Properties page.
5. Make the desired changes and then click Save.
8.6.2 Displaying a list of workspaces that use a data source connection

An Analysis data source connection can be used by several workspaces. Before you delete a connection, verify that the list of workspaces using that connection is empty.

8.6.2.1 To see a list of workspaces that use a data source connection

1. Start the Central Management Console.
   For example, on Windows, click Start ➔ All Programs ➔ SAP Business Intelligence ➔ SAP BusinessObjects BI platform 4 ➔ SAP BusinessObjects BI platform Central Management Console.
2. Log on to the Central Management Console.
3. In the Organize area in the CMC, select OLAP Connections.
4. Select a data source connection and click Actions ➔ Workspaces.
   Alternatively, you can right-click the connection and select Workspaces.
   The list of workspaces that currently use the data source connection is displayed.

8.6.3 Changing access to Analysis data source connections

After saving a data source connection to the BI platform, you can use the CMC to change its access permissions.

8.6.3.1 To change access to data source connections

1. Start the Central Management Console.
   For example, on Windows, click Start ➔ All Programs ➔ SAP Business Intelligence ➔ SAP BusinessObjects BI platform 4 ➔ SAP BusinessObjects BI platform Central Management Console.
2. Log on to the Central Management Console.
3. In the Organize area in the CMC, select OLAP Connections.
4. Select a data source connection and click Manage ➔ User Security.
   Alternatively, you can right-click the data source connection and select User Security.
5. Click the User or Group name for which you want to change the access, and then click Assign Security.
6. Assign the appropriate access levels or rights, and then click OK.
8.6.4 Replacing an Analysis data source connection

In some situations, you may want to replace the data source used by a workspace with another one. Reasons for replacing a data source include the following:

- The data source used by the workspace was deleted, and users can no longer open that workspace.
- You want to edit some data source connection details (for example, to connect to a different server) but do not want to modify the existing data source connection object. Instead, you want to create a new data source connection and update the workspace to use the new connection.

8.6.4.1 To replace a data source connection

1. Start the Central Management Console.
   
   For example, on Windows, click Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console.

2. Log on to the Central Management Console.

3. In the Organize area in the CMC, select Folders or Personal Folders.

4. Expand the folder list as needed to locate the workspace whose connection you want to replace.

5. Select the workspace and then select Connections from the Actions menu.

6. Click Replace Connection at the top of the connections listing page.

7. In the Current Connection column, find the connection that you want to replace, and then in the Replace With column, click the arrow to the right of the connection name to open a list of available connections.

8. Choose a replacement connection from this list.

9. If you want to apply the changes to all workspaces that use the same connection, select the Apply changes to all workspaces option.

10. Click Save and then Close.

   Once the connection is replaced, open the workspace in the BI launch pad to verify that the workspace is linked to the new connection.

     i Note

     The current connection and the new connection must have the same data layout.
8.7 Configuring connections for Report-Report Interface

8.7.1 Enabling SAP BW query targets for the Report-Report Interface

To allow users to access SAP BW data source targets using the Report-Report Interface (RRI), you must create a connection to the data source system that hosts SAP BW data sources that have RRI configured. Connections to specific queries do not allow users to access those queries through RRI; a connection to the system must be available. After you add this connection, users can add new data sources to their analysis by right clicking a crosstab member and selecting a query target in the Go To list.

RRI links are configured in the Business Explorer (BEx) Query Designer of SAP BW. For more information, see the documentation for SAP technology on the SAP Help Portal at http://help.sap.com.

Related Information

Creating OLAP data source connections [page 63]

8.7.2 Enabling single sign-on for RRI

The Report-Report Interface in Analysis can use single sign-on (SSO) if it is configured properly.

For example, a user may log onto SAP Enterprise Portal before opening an Analysis workspace. In this case, SSO must be configured on the SAP Enterprise Portal, the BI platform, and the RRI targets that require authentication.

For example, SSO can be configured for an RRI target such as an ERP transaction, which can be accessed through SAP GUI for HTML. If an Analysis user has logged on to the SAP Enterprise Portal, they can open the ERP transaction through RRI without entering their credentials again.

If you want to enable SSO to SAP BW data source connections, you must set the authentication type for the SAP BW system to SSO. See Data source connection settings [page 71] for more information.
9 Managing Workspaces

9.1 Overview

The Central Management Console (CMC) is a web-based administration tool for managing Analysis data source connections and workspaces, user accounts, rights, folders, server settings, and license keys. You must be a BI platform administrator to access the CMC.

From the CMC, you can change the properties of a saved Analysis workspace.

9.2 Editing the title, description, and keywords of an Analysis workspace

You can use the CMC or BI launch pad to edit the title, description, and keywords of an Analysis workspace that has been published to SAP BusinessObjects Business Intelligence platform.

9.2.1 To edit the title, description, and keywords of an Analysis workspace in the CMC

1. Start the Central Management Console.
   For example, on Windows, click Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console.
2. Log on to the Central Management Console.
3. In the Organize area in the CMC, select Folders or Personal Folders.
4. Expand the folder list as needed to locate the workspace whose properties you want to edit, and then double-click the title of the workspace to open the Properties page.
5. Make the desired changes and then click Save.

9.2.2 To edit the title, description, and keywords of an Analysis workspace in the BI launch pad

1. Start the BI launch pad and log on.
   For example, on Windows, click Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console.
2. Click the *Documents* tab.
3. Expand the folder list as needed to locate the workspace whose properties you want to edit, and then select the workspace title.
4. Click *View ➤ Properties* to open the Properties page.
5. Make the desired changes and then click *OK*.

### 9.3 Displaying a list of connections linked to the workspace

An Analysis workspace can be linked to several data source connection objects.

### 9.3.1 To see a list of connection objects linked to the workspace

1. Start the Central Management Console.
   
   For example, on Windows, click *Start ➤ All Programs ➤ SAP Business Intelligence ➤ SAP BusinessObjects BI platform 4 ➤ SAP BusinessObjects BI platform Central Management Console*.
2. Log on to the Central Management Console.
3. In the Organize area in the CMC, select *Folders or Personal Folders*.
4. Expand the folder list as needed to locate the workspace whose connections you want to view.
5. Select the workspace, and click *Actions ➤ Connections*.
   
   All connection objects that are linked to the workspace are listed.
10 Sharing Workspaces

10.1 Sharing workspaces using OpenDocument URLs

Analysis workspaces can be shared using OpenDocument URLs, which contain a unique document ID. Instead of opening the workspace through the BI launch pad, users can click the URL to jump directly to the workspace. For more information about OpenDocument, refer to the *Viewing Documents Using OpenDocument* guide available on the SAP Help Portal at http://help.sap.com.

As an administrator, you can use OpenDocument URLs to provide easy access to frequently used Analysis workspaces. For instance, you can create a URL iView in SAP Enterprise Portal and configure single sign-on between Enterprise Portal, BI platform, and, if necessary, BEx query data sources. Using this iView, users can access the Analysis workspace from Enterprise Portal without entering their credentials multiple times.

10.1.1 Setting prompt values using parameterized OpenDocument URLs

If an OpenDocument URL points to a workspace based on SAP BW data sources, users may be prompted to specify variable values before opening the workspace. To avoid this step, you can add parameters to a URL to specify values for each mandatory variable for the workspace. When users click a URL that is parameterized correctly, the *Prompts* dialog box does not appear and users can view the workspace immediately. Users are able to change the prompt values after opening the workspace, if necessary.

In a single OpenDocument URL, you can specify values for multiple variables of different types and from different data sources. However, parameterized URLs for SAP HANA data sources are not supported in this release.


10.1.2 Creating parameterized OpenDocument URLs

To construct a parameterized URL, you need the following elements:

<table>
<thead>
<tr>
<th>URL element</th>
<th>Description</th>
<th>References</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base URL</td>
<td>Before you add parameters to an OpenDocument URL, you must copy the base URL for the workspace. You can find this URL through the Documents</td>
<td>Refer to the “To get the URL for a workspace” section of the SAP BusinessObjects Analysis, edition for OLAP User Guide available on the SAP Help Portal at <a href="http://help.sap.com">http://help.sap.com</a>.</td>
</tr>
<tr>
<td>URL element</td>
<td>Description</td>
<td>References</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>tab in BI launch pad, or in the Analysis client.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical names for variables and variable values</td>
<td>You identify variables and values in the OpenDocument URL using their technical names. For SAP BW, you can find these technical names in the BEx Query Designer.</td>
<td>For SAP BW, refer to the documentation for SAP technology available on the SAP Help Portal at <a href="http://help.sap.com">http://help.sap.com</a>.</td>
</tr>
</tbody>
</table>
11 Scaling and Performance

11.1 Clustering MDAS instances

The Multi-Dimensional Analysis Service is inherently memory bound. As the number of users increases, so does the number of queries that must be handled, and therefore so does the MDAS memory requirements.

For this reason, you may want to cluster multiple MDAS instances together. Analysis automatically identifies and makes use of clustered MDAS instances without further configuration.

For more information about clustering BI platform servers and services, including the MDAS, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

For more information on memory optimization, see the SAP BusinessObjects BI Sizing Companion Guide.

11.2 Load balancing

Like other BI platform services, you can install multiple MDAS instances. Once you have installed the MDAS on a single machine, you can create multiple MDAS instances on that machine using the Central Management Console.

You can also choose to install the MDAS on different machines to distribute the load.

For more information about clustering BI platform servers and services, including the MDAS, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

Related Information

Server failover [page 15]
Clustering MDAS instances [page 90]

11.3 Optimizing performance

Analysis performance can be optimized by following the recommendations described in the SAP BusinessObjects BI Sizing Companion Guide.
11.4 Configuring Analysis for scalability against Essbase 11 data sources

This section explains the recommended configuration to improve scalability and help avoid connection errors when using Analysis, edition for OLAP to connect to an Essbase 11 data source.

When using Analysis to connect to an Essbase 11 data source, performance may be slower when the number of concurrent users exceeds 15. With the proper configuration, Analysis continues to function with no APS connection errors when there are over 15 concurrent users, but performance may degrade significantly.

This optimal concurrent user load assumes that 70 percent of the users are using Analysis to consume data, while 30 percent of the users are analyzing data.

The cause of the scalability limitation is that the Essbase client interface consumes many ephemeral ports for TCP/IP connections to the Essbase server, and the machine has a limited number of ports.

In the absence of available ephemeral ports, the Essbase client will fail to connect due to a timeout error. An Essbase JAPI exception will be thrown and captured in the APS log. The following is an example error:

com.essbase.api.base.EssException: Cannot set active application/cube. Essbase Error(1042006): Network error [10061]: Unable to connect to [<machine.domain.com>:1423]. The client timed out waiting to connect to Essbase Agent using TCP/IP. Check your network connections. Also make sure that server and port values are correct.

If connection errors occur in the APS log, implement the following recommendations, in the order listed:

1. Increase available ephemeral ports
2. Reduce TIME_WAIT state
3. Increase connection retry count

Based on your business requirements, some of the steps may be unnecessary. For example, if increasing the number of ephemeral ports is sufficient for the expected user load, the last two steps can be skipped.

11.4.1 Increasing available ephemeral ports

You can improve scalability by increasing the number of available ephemeral ports on the APS machine running the MDAS. The maximum recommended port range is 5000–65535.

For Windows 7 and Windows Server 2008:

- Use the following command to display the current dynamic port range: `netsh int ipv4 show dynamicport tcp`
- Use the following command to set the dynamic port range: `netsh int ipv4 set dynamic tcp start=5000 num=65535`

For Linux:

- Use the following command to display the current dynamic port range: `cat /proc/sys/net/ipv4/ip_local_port_range`
- Use the following command to set the dynamic port range: `echo "5000 65535" > /proc/sys/net/ipv4/ip_local_port_range`
Increasing the number of ports improves scalability, but client connection errors can still occur from the APS. For more information, refer to the following article: http://support.microsoft.com/kb/929851

11.4.2 Reducing the TIME_WAIT state

You can improve scalability by reducing the time that must elapse before the TCP can release a closed connection and reuse its resources. This period is known as the TIME_WAIT state. It is recommended that you set the time to the minimum value, which is 30 seconds.

For example, on Windows, edit the following registry entry to have decimal value 30:

```
HKLM\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters\TcpTimedWaitDelay
```

On Linux, use the following command to set the tcp_fin_timeout parameter to 30 seconds:

```
echo 30 > /proc/sys/net/ipv4/tcp_fin_timeout
```

Reducing the TIME_WAIT state improves scalability, but client connection errors can still occur from the APS. For more information, refer to the following articles:


11.4.3 Increasing the connection retry count

The connection retry count is the number of attempts that the Essbase client will make to connect to the Essbase server.

You can reduce the number of client connection errors from the APS to the Essbase server by increasing the connection retry count. Increasing the connection retry count does not improve scalability.

You can set the connection retry count using the Java property `olap.server.netConnectRetry` on the JVM that loads the Essbase JAPI. The maximum recommended setting is 8000.
12 Monitoring and Logging

12.1 Auditing

Auditing is a feature of the BI platform that allows administrators to keep a record of significant events on BI platform servers and applications, such as opening data source connections and modifying workspaces. The recorded information helps you to understand what information is being accessed, how it's being accessed and changed, and who is performing these operations.

Analysis registers an auditing event whenever one of the following operations occurs:

- A new workspace or analysis view is created.
- A workspace or analysis view is saved.
- A workspace or analysis view is deleted.
- A workspace or analysis view is viewed.
- A workspace or analysis view is exported to a different format.
- A connection to an MDAS is established.
- A connection to an MDAS is closed.
- A connection to a data source is established.
- A connection to a data source is closed.

For more information about auditing, see the “Auditing” section in the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

12.2 Trace logging

Tracing allows system administrators and support personnel to monitor the performance of BI platform components (servers and web applications) and the activity that occurs within the monitored components.

Traces are recordings of events that occur during the operation of a monitored component. System-level messages generated by BI platform servers are traced and written to log files. These log files are used by system administrators to monitor performance or to debug problems.

For more information about tracing, see the section “Managing and Configuring Logs” in the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

12.3 To enable statistics for Analysis on an SAP BW server

To enable statistics on an SAP BW server for Analysis, edition for OLAP, you must perform the following steps:
1. Enable statistics on the SAP BW server for the BEx Query or InfoProvider whose statistics you want to log.

2. On the BI platform server, open the `mdas.properties` file.
   
   On Windows systems, the `mdas.properties` file is located in this directory:
   
   `<BOE_INSTALL_DIR>\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\java\pjs\services\MDAS\resources\com\businessobjects\multidimensional\services\`
   
   where `<BOE_INSTALL_DIR>` is the file path for the installation directory (by default, `C:\Program Files (x86)`).

   On UNIX systems, the `mdas.properties` file is located in this directory:

   `<BOE_INSTALL_DIR>/sap_bobj/enterprise_xi40/java/pjs/services/MDAS/resources/com/businessobjects/multidimensional/services/`

3. Change the value of the `multidimensional.services.bics.profiling.enabled` property from `false` to `true`. Save and close the file.

4. Open the Central Management Console and restart the Adaptive Processing Server that hosts the Multi-Dimensional Analysis Service (MDAS).

5. Using SAP Logon, turn on the statistics switch using the RSDDSTAT transaction and set the logging on the BEx Query or InfoProvider.

6. After you perform the desired workflow in Analysis, edition for OLAP using the query for which statistics were enabled, you can access statistical data by using the SE16 transaction and examining the `RSDDSTAT_Olap` table.


If you no longer want to log statistics for Analysis on the SAP BW server, you must revert these changes. Disable statistics for the BEx Query or InfoProvider, set the `multidimensional.services.bics.profiling.enabled` property back to `false`, and restart the Adaptive Processing Server that hosts the MDAS. Using SAP Logon, turn off the statistics switch using the RSDDSTAT transaction.

**Related Information**

- Configuration files for the MDAS Server [page 57]
- Restarting the Multi-Dimensional Analysis Service [page 56]
13  Microsoft Analysis Services Considerations

13.1  IIS configuration for MSAS connectivity

To configure IIS for MSAS connectivity, perform the following steps.

1. Copy required files [page 95]
2. Create an Application Pool [page 96]
3. Create a Virtual Directory [page 96]
4. Configure Security [page 96]
5. Set up a Web Service Extension [page 97]

Once these steps have been completed, you can create new connections to MSAS data sources.

Related Information

Creating OLAP data source connections [page 63]
Data source connection settings [page 71]

13.1.1  Copy required files

1. Copy required files [page 95]
2. Create an Application Pool [page 96]
3. Create a Virtual Directory [page 96]
4. Configure Security [page 96]
5. Set up a Web Service Extension [page 97]

Once these steps have been completed, you can create new connections to MSAS data sources.

Related Information

Creating OLAP data source connections [page 63]
Data source connection settings [page 71]

13.1.1  Copy required files

It is assumed that the Windows server has already been configured for the Web Server (IIS) role. You can confirm or add this role by using the Server Manager. Click Start ➤ Run and type ServerManager.msc.

1. Create a new folder inside c:\inetpub\wwwroot named olap.
2. Copy the folder and files inside the SSAS isapi folder to the IIS olap folder.
   For example, if SQL Server 2008 R2 is installed, then copy everything inside c:\program files \microsoft sql server\msas10.mssqlserver\olap\bin\isapi to c:\inetpub\wwwroot\olap. The olap folder should now contain a Resources folder and two files: msmdpump.dll and msmdpump.ini.
3. Start the IIS Manager: click Start ➤ Run and type inetmgr.
4. In the Connections panel, expand “Sites” and then expand “Default Web Site”, and verify that a folder named olap has been added.
13.1.2 Create an Application Pool

1. In the Connections panel, right-click “Application Pools” and select “Add Application Pool”.
2. In the “Add Application Pool” dialog box, enter the following information and then click OK:

<table>
<thead>
<tr>
<th>Name</th>
<th>olap</th>
</tr>
</thead>
<tbody>
<tr>
<td>.NET Framework version</td>
<td>.NET Framework v2.0.50727</td>
</tr>
<tr>
<td>Managed pipeline mode</td>
<td>Classic</td>
</tr>
<tr>
<td>Start application pool immediately</td>
<td>select this option</td>
</tr>
</tbody>
</table>

3. In the Connections panel, click “Application Pools” and verify that the “olap” application pool now appears in the “Application Pools” panel.
4. Right-click the “olap” application pool and select “Advanced Settings”.
5. In the “General” category, set “Enable 32-Bit Applications” to “False”.
6. In the “Process Model” category, set the “Identity” to “NetworkService”, and then click OK.

13.1.3 Create a Virtual Directory

1. If IIS Manager is not already running, start it: click Start Run and type inetmgr.
2. In the Connections panel, expand “Sites” and then expand “Default Web Site”.
3. Right-click the olap folder and choose “Add Virtual Directory”.
4. In the “Add Virtual Directory” dialog box, enter the following information and then click OK:

<table>
<thead>
<tr>
<th>Alias</th>
<th>olap</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical path</td>
<td>c:\inetpub\wwwroot\olap</td>
</tr>
</tbody>
</table>

5. In the Connections panel, right-click the “olap” folder and choose “Convert to Application”.
6. In the Add Application dialog box, select “olap” for the “Application pool” and then click OK.

13.1.4 Configure Security

Multiple authentication options are available.

- Anonymous authentication is enabled by default but should be turned off, unless there is no plan to use any of the SSAS security features. With Anonymous authentication enabled, SSAS has no way of differentiating between different users. However, enabling Anonymous authentication can be useful when troubleshooting connectivity issues.
- Basic authentication requires a username and password to be entered. It is mandatory that Basic authentication be enabled when defining OLAP connections in the CMC. Once the connections have been defined, Basic authentication can be disabled.
- Windows authentication is the most secure authentication, and is recommended. It must be enabled to configure single sign-on (SSO).
1. In the Connections panel, select the “olap” application. This is the folder that you converted to an application in the “Create a Virtual Directory” step.
2. Choose the Features View, and open “Authentication” in the “IIS” features category.

### 13.1.5 Set up a Web Service Extension

1. In the Connections panel, select the “olap” application.
2. Choose the Features View, and open “Handler Mappings” in the “IIS” features category.
3. Right-click in an empty area with nothing selected, and choose “Add Script Map”.
4. In the “Add Script Map” dialog box, enter the following information and then click OK:

<table>
<thead>
<tr>
<th>Request path</th>
<th>*\dll</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executable</td>
<td>c:\inetpub\wwwroot\olap\msmdpump.dll</td>
</tr>
<tr>
<td>Name</td>
<td>olap</td>
</tr>
</tbody>
</table>
5. Click “Request Restrictions”, and then in the Verbs tab select “All verbs”.
6. Click Yes when prompted to allow the ISAPI extension.

### 13.2 Analysis, edition for OLAP and Analysis Services security

This section explains how to set up the SAP BusinessObjects services to be able to authenticate to Microsoft Analysis Services.

#### 13.2.1 Analysis Services role security

SQL Server Analysis Services security architecture is built on Microsoft Windows authentication. To access data in Analysis Services, users must connect with an account that can be authenticated by Microsoft Windows. Analysis Services does not recognize user accounts created in the native SQL Server Database (relational) Engine security system, such as the built-in administrator’s account "sa". After authenticating the user, Analysis Services checks the security roles that the user belongs to, to determine which cubes, dimensions, members and cell values to return.

To allow users to view data in an Analysis Services cube from Analysis, you must first define the appropriate security roles on the target cube.
13.2.1.1 To define a security role in Analysis Services 2008 or 2012

1. Open Microsoft SQL Server Management Studio and connect to the Analysis Services instance.
2. Expand the folder structure for the database.
3. Right-click the Roles folder and select New Role.
4. Enter a name for the role in the Role Name field and select the Read Definition checkbox so the users have read rights.
5. Click Membership in the left pane and click Add to add the list of domain users that will be given read access to the database.

   **Note**
   If there are a large number of users, it may be more efficient to create a group within Active Directory for OLAP access and add all the users to the group, then simply add the group to the list.

6. Select the appropriate user permissions by clicking Data Sources, Cubes, Cell Data, Dimensions, Dimension Data and Mining Structures to decide what areas the users will have read access to.

   **Note**
   The extent of how much of the data you want users to have access to is dependent on the reports being created and security within your organization and security should be planned accordingly.

13.2.2 Finding more information

**Analysis Services security and authentication**

- SQL Server 2008/Analysis Services Service Pack downloads: [http://support.microsoft.com/kb/968382](http://support.microsoft.com/kb/968382)
- SQL Server 2008 R2/Analysis Services Service Pack downloads: [http://support.microsoft.com/kb/2527041](http://support.microsoft.com/kb/2527041)

**Calculation solve order**

14 Converting Workspaces to Analysis

14.1 Converting workspaces from Voyager to Analysis, edition for OLAP

If you are moving from Voyager to Analysis, edition for OLAP, use the upgrade management tool to convert your Voyager workspaces to the Analysis format. The upgrade management tool is provided with SAP BusinessObjects Business Intelligence platform.

**Note**
If you are using Voyager XI Release 2, or XI 3.0, you will need to first upgrade to XI 3.1 before converting to the current version of Analysis.

The upgrade management tool provides two upgrade options; a complete upgrade or an incremental upgrade:

- **Complete upgrade**
  The complete upgrade process converts all objects of all types. Minimal effort and interaction are required, but the process can take many hours to complete.

- **Incremental upgrade**
  The incremental upgrade process allows you to choose which objects to convert. The objects are grouped by type, so that you can select all Voyager workspaces for example.

Because Analysis data source connections are formatted differently from Voyager connections, Voyager objects will fail to convert when the complete upgrade is performed. Therefore, before you convert your Voyager workspaces, you will need to manually recreate your Voyager data source connections in SAP BusinessObjects Business Intelligence platform 4.1.

You can perform the upgrade in one of two ways:

- **Perform a complete upgrade first.** All Voyager objects will fail to convert but other objects will migrate successfully. After the complete upgrade finishes, manually recreate your Voyager data source connections in the CMC in SAP BusinessObjects Business Intelligence platform 4.1. Then perform an incremental upgrade for Voyager workspaces.

- **Manually recreate your Voyager data source connections in the CMC in SAP BusinessObjects Business Intelligence platform 4.1.** Then perform a complete upgrade.

**Note**
When you manually recreate your data source connections, the Analysis connection names used in 4.1 must be the same as the Voyager connection names used in XI 3.1.

For more information, see the SAP BusinessObjects Business Intelligence Platform Upgrade Guide available on the SAP Help Portal at http://help.sap.com, and the Converting Voyager Workspaces to Analysis Edition for OLAP Workspaces white paper available in the SAP BusinessObjects Analysis, edition for OLAP community space on the SCN.
15 Translating workspaces

15.1 Preparing Analysis workspaces for translation

Analysis workspaces can be translated using the translation management tool in version 4.1 SP4 and later.

Workspaces that were created in previous versions of Analysis must be opened and saved in Analysis, edition for OLAP version 4.1 SP4 or later.

Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP’s gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP’s current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of wilful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP’s gross negligence or willful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).